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Foreword

Foreword

For the most part, you don't really need to read this
document. Since the Semantix Roaming Studio application is
intuitively easy to use we encourage you to simply fire up the
application and start working with your TAP files. Online help

for the rare cases you may need it is available through the
application’s graphical user interface. The online help in
Semantix Roaming Studio version 2.0.0 and this document
contain identical information and are synchronized.
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Introduction

Semantix Roaming Studio is a desktop application that enables you to view, edit, validate,
import/export and perform miscellaneous other operations on TAP, RAP and NRTRDE files through a
rich Graphical User Interface (GUI).

Semantix Roaming Studio version 2.0 works with all TAP3 releases (TAP3.1 up to TAP3.11 as of
October, 2008), RAP1.4 (for all TAP releases) and NRTRDE 2.1.

This guide covers installation and user operations but doesn't deal with licensing and activation.

The guide and the screenshots also describe and apply to the activated version of the product. Note
however that there are practically no differences in the working environment and supported features
between the activated and the evaluation (not activated) versions. The only difference is that the
"save" button is disabled in the evaluation version.

Acronyms and Abbreviations

ASCIl  American Standard Code for Information Interchange

ASN.1 Abstract Syntax Notation One (1)
DLL Dynamically Linked Library

EULA End-User Licence Agreement

GUI  Graphical User Interface
MDI  Multiple Document Interface
TAP Transferred Account Procedure
RAP Returned Account Procedure

NRTRDE Near Real-Time Roaming Data Exchange

© 2011 Semantix Information Technologies S.A.
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2.1

2.2

2.3

Installing Semantix Roaming Studio

This chapter provides information on installing Semantix Roaming Studio.

Please note that in all cases you need Administrator privileges on the machine on which you install
Roaming Studio.

Installation Environments

Semantix Roaming Studio is a .NET-based application and can be installed on the following
environments:

e Windows XP, Internet Explorer 6 with SP3 and .Net 3.5
¢ Windows Vista with SP1 and .Net 3.5
e Windows Server 2003 and .Net 3.5

A bare minimum hardware configuration required to run Roaming Studio is show on the table below:
e 256 MB of RAM

e 300 MB HD

e SVGA (1024x768 and upwards)

However, the following hardware configuration is recommended:
¢ 1GB of RAM

e 500 MB HD

e SVGA (1024x768 and upwards)

Installation Instructions

To Install Semantix Roaming Studio, you simply have to run "RoamingStudio.2.0.NNNN.exe" (where
"NNNN" is the minor release number) and then follow the instructions of the Installation Wizard. If you
don't have .NET 3.5 installed, the installation program will notify you and take you to the appropriate
download page on Microsoft.com. The requirement to have .NET 3.5 installed is one of the reasons
that Administrator privileges are required to perform the installation.

Testing the Installation

After the installation, select
Start-> Programs—> Semantix Roaming Studio 2.0 - Roaming Studio

The Roaming Studio splash screen will appear briefly, to be shortly followed by the main application
window. Selecting Help—> About will display the dialog depicted in the figure below, identifying the
version of the application (at the time of writing this, at 2.0.3336.22820).

© 2011 Semantix Information Technologies S.A.
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Note that the screenshot below is from an un-activated (evaluation) version.

About Semantix Roaming Studio

Semantix Roaming Studio
Yersion 2.0.3336. 22820
Copyright & Semantiz Information Technologies 5.4, 2001-2009

hittp: £ v, tapeditar. com

X)

Wharning: This computer program is protected by copyright law and international
treaties. Unautharized repraduction or distribution of thiz program, or any partion of it,
may result in severe civil and criminal penalies, and will be prozecuted to the
maximunm extent possible under the law.

Tral Version
Evaluation days left; 26
Evaluation uzes left; 58

View the End-User Licenze Aagresment

“About” dialog for Semantix Roaming Studio, version 2.0.3336.22820.

© 2011 Semantix Information Technologies S.A.
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The Working Environment

This Chapter describes the GUI of the Roaming Studio. Kindly note that the discussion and the
screenshots apply to the activated versions of the product (i.e. not the evaluation version), unless
otherwise noted.

Once installed, you can launch Semantix Roaming Studio through

Start-> Programs—> Semantix Roaming Studio 2.0 2 Roaming Studio

gj My Computer »

rﬂ Programs

I Microsoft Office b

_ I Skype 3

g I& Documents i Startup b

@ _ - adobe Acrobat 7.0 Professional

_E E}' settngs ' ) EmEditor

Q_E f;j Search b @ Internet Explorer

- f@ Semantix Roaming Studio 2.0

> 9 Help and Support I TortoiseSvN d ¥ Roaming Studio
§ 7 Run... I HTML Help Workshop b |@E User's Manual
E * l

= @ Shut Dawn...

W 3 WindowsEx... ~ | (2 Help & Manual [... )

Launching Roaming Studio

Once launched the main application window appears on screen with no file loaded as depicted in the
figure below.

© 2011 Semantix Information Technologies S.A.
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£ Semantix Roaming Studio

sﬁé‘hﬁ‘gur_e ~windows  Help

Ready

Roaming Studio main application window

To open a new file for viewing or editing, use the menu: File= Open. A file dialog appears as depicted
in the figure below.

© 2011 Semantix Information Technologies S.A.
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Open file as

Look jr: | |2 zamples

B

ky Recent
Documents

&l

Deszkiop

&

by D ocuments

ky Computer

CDDELD2GRCPF 10000, sample

File name:

@

by M etwork, Files of twpe:

File Grammar:

Open

| CDDEUDZGRCPF0000.sample v|

|l fles %) v

| Automatic Detect L |

Roaming Studio File Open dialog.

When you select the file you want and press the Open button the TAP/RAP/NRTRDE file is read from
disk and its contents are displayed on your screen. The file type is automatically detected if you leave
the "File Grammar" combo box to "Automatically Detect" - otherwise, Roaming Studio will attempt to
decode the selected file using the chosen format. The following figure provides a typical screenshot

after the loading of a TAP file:

© 2011 Semantix Information Technologies S.A.
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OE®

£ Semantix Roaming Studio - [C:\Program Files\Semantix\Semantix Roaming Studiolsamples\CDDEUD2GRCPF10000.sample]

ol File Edit  Wiew Validations

Configure

Windows  Help

=T

HERT BN

i = | ﬁ] X By @ 3 |9 ']iéﬁFindi v=%|ale|@CaIISearch W | Gato cal
= ) Dataiéerchange = | batchContralinfo : Diata Dictionary 3 x
=) fransfaraich E DELIDZ \-:J..'\'-.-'\ ST aii
o trollnfo £} recipient: GRCP | Sender M |
|C5) accountingInfo fileSequencetumber: 10000 5
sender =

[5) netwarkInfo
[{j messageDescriptionInfo
=10 calfveniDetais
[

| auditControlinfa

= f;;} fileCreationTimeStamp
localTimeStamp: 200509071 20940
utcTime0ffget: +0300

q localTimeStarmp: 200503071 20340
utcTime0ffset: +0300

localTimeStamp: 200503071 20940
: utcTimeO ffzet: +0300

13 specification'/ersionMumber. 3

1 releaseVersionMumber. 11

= rapFileS equenceMumber. 09333
[=1-i) operators peclnformation

Walidations ASH.1 Parent Types
& uricpae identifier used to determine the
network which is the Bender of the data.
The full list of codes in use are given in TADIG
PRD TD.13: FMHN Naming Conventions.
Condifionality:
Mandatory within group Hotification.
Mandatory in group Batch Control
Information.

Example confent:

=) [1]OperatorSpecinformation:  Test case ge Code
= GERCN
GERFF
DREUDI
DEUD2
Nofe: These codes must be in uppercase (as
defined in TDV 13 ). 3
< | >
D el [Daererel [P amigal B3 iciiia
Element Error Code Severity Qcc... | Description
1) | >

Validation results | Call search results

Readsy

Typical TAP file opened in Roaming Studio

The screen of the application is divided into 6 main areas as depicted in the following figure.

© 2011 Semantix Information Technologies S.A.
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£ Semantix Roaming Studio - [C:\Program Files\Semantix\Semantix Roaming Studio\samples\CDDEUD2GRCPF10000.sample] El@‘g‘
Area | oo Fie Edt Wiew \Validstions  Configre  Windows  Help .8 x

Area 2 I A=A | @J ¥ E3 A X | Ji%Find v B | de | (5 callSearch 7 | o to cal J 2 @‘33] I

() networkInfo

L;j messageDescriptionInfo
=) cafEventtetars

i o

(3 auditControlInfo

Area 3

ileCreationT imeStarmp
=] locallTimeStamp: 20050507120940
=] uteTimelffsat: +0300

=+ transferCutd i TimeStamp
=] localTimeStarnp: 20050307120340
=) utcTimelffset: +0300

=1 filedeeailableTimes tamp
=] localTimeStarnp: 200503071 20340
=] utcTimeOffset: #0300

=209

= [ DatainterChange i Data Dictionary 2 x
=03 tranzfardatch |Sender
E : GRCPF
ileSequenceNumber: 10000 sender

Walidations ASH.1 Pavent Types

A unigue identifier used to determine the
network which is the Sender of the data.

The full list of codes in vse ate given in TADIG
FED TD.13: PMN Naming Convertions.

Conditionalify:
Wandatory within group Motification

9 specificatiorersionNumber 3 Area & Mandatory in group Batch Control

o releaseVersionMumber. 11 Infarmation.
=] rapFileSequenceNumber 09333 [Example content:
=-3 operatoiSpecinformation Code
=) [1]0peratorSpecinformation:  Test case ge GRRCIN
GERVF
DEUDI
DEUD2
Area d

[Nofe: These codes must be in uppercase (as
defined in TD 13)

w
< >
[ ] [ |
Element Error Code Severity Occ... Description
Area 6
< »
Ready Walidation results | Call search results

Application screen areas in Roaming Studio.
The areas depicted in Figure 5 are as follows:
o Area #1 is the menu area.

Area #2 is the toolbars area.

Area #3 is the file view area.

Area #4 is the call and sub-structures view area.

Area #5 is the documentation area.

Area #6 is the validation and call search area.

The sections that follow describe each of these areas in detail.

Main Menu Area

The main menu area contains the following menus:

e File menu: contains operations for opening, creating, merging, importing, exporting files and for
reporting on their contents. It is examined in subsection File Menu.

e Edit menu: contains operations for modifying individual fields in TAP/RAP/NRTRDE files and call

© 2011 Semantix Information Technologies S.A.
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search/filter operations. It is examined in subsection Edit Menu.

e VView menu: controls the appearance of the various toolbars and toggles on and off the main areas
that comprise the screen. It is examined in subsection View Menu.

o Validations menu: Instructs Roaming Studio to validate the file, automatically re-compute summary
fields in the file and also controls the display of fatal and severe errors (as well as warnings)
allowing the user to browse through these classes of errors. It is examined in subsection Validations
Menu.

e Configure menu: The purpose of this menu is to enable the user to configure reference data for his
local Roaming Studio installation and to customize validation rules and logic in a custom, client-
specific manner. It is examined in detail in subsection Configure Menu.

¢ Windows menu: The Roaming Studio is an MDI application so the role of this menu is to expose
typical commands and options that control window placement when multiple files are simultaneously
opened. It is examined in subsection Windows Menu.

e Help menu: Used to access the online help system, search help contents and display the about
dialog. Described in subsection Help Menu.

3.1.1 File Menu

As shown in the figure below, the File menu contains the following menu items and sub-menus:

¥ Semantix Roaming Studio - [C:XTAPKIT-

ol | File | Edit  Yiew  Validations  Configure

el New... Chr-+H |l
Open ... Chrl+O 1
= [ Open F
Close
[ save Chrl+5
Save As ...
Save Al Ckrl+Shift+5

Creakte Summary Repork ...

Merge TAP3S Files ...

Export Ta 3
Import From ]
Recent Files 3
Exit

The File menu

© 2011 Semantix Information Technologies S.A.
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e New ...: Creates a new, empty TAP/RAP/NRTRDE file (allowing the user to first select the version
desired):

New File x|

Pleaze zelect version

| TAF Verzsion=03 Releaze=11

ak, Cancel

e Open ...: A standard file dialog pops up allowing the user to choose a TAP/RAP/NRTRDE file to
open.

e Close: Closes the currently opened TAP/RAP/NRTRDE file
e Save: Saves the currently opened TAP/RAP/NRTRDE file on the same location it was read from.

e Saveas.... A standard file dialog pops up allowing the user to choose the name and the directory
where the currently opened TAP/RAP/NRTRDE file is to be saved.

o Save All: All opened TAP/RAP/NRTRDE files are saved in their original locations.

e Create Summary Report ... A summarizing report in RTF format is created for the topmost TAP file
currently opened in Roaming Studio. The report is opened as a separate window of the Roaming
Studio application and upon its creation the initially disabled Print ..., Print Preview... and Print
Setup... menus become operational allowing the user to print the report as depicted in the following
figure:

© 2011 Semantix Information Technologies S.A.
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¥ Semantix Roaming Studio - [FileSummary Report :C:\TAPKIT\SampleData\3.10\CDDEUD2GRCPF10000.fu... (= |[B)fX]

o-l File Edit Wiew Configure  Windows  Help - 3 X
Rap=a" N
Summary Report for C\TAPKIT\SampleData'3.10 &
\CDDEUD2GRCPF10000 full tap310
Eeport generated by SEMANTIY Roaming Studia,
on Mon Jun 26 11:.34:43 2006
Cut off Time stamp LO050%07120940 +0300
Creation Tunestamp 0050807120940 +0300
Avallable Timestamp 0050507120540 +0200
Interm. Access Code 0
Country Code 19
Local Cwrency ETTE.
Total calls 3
Total charges i
Total taxes 4
Total discounts 008
Earliest call 0050507100240 +0300
Latest call PO050207100940 +0300
|
Ceells Charges Texes \Discannis
MMobile Onigimated Call 1 ] 05 001
MMobile Terminated Call 1 ] 05 001
Supplementary Service Event [ e 05 001
Value Added Service 1 ) 05 001
Service Centre Usage 1 D 05 001
IGPRS Call 1 5 05 0m
Content Transaction 1 3 03 .00
Location Service 1 D 05 001 7
Ready .

A typical summary report created from the File menu

e Create RAP Acknowledgment: (available only when a RAP file is opened) Selecting this option will
create a RAP file acknowledgment, after asking for some additional information through the
following dialog:

© 2011 Semantix Information Technologies S.A.
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RAP Batch Control Information

X

Enter infarmation
Sender
Recipient | CYPCT
Seguence Mo | 12345

Raarming Partner

k. ] [ Cancel ] [ Help

Extra information needed for RAP file acknowledgment

oo o1~ WN P

Print ...: (Enabled only when a report is opened in Roaming Studio) As expected, it allows you to
print the report.

Print Preview ...: (Enabled only when a report is opened in Roaming Studio) Preview a report you are
about to print.

Print Setup ...: (Enabled only when a report is opened in Roaming Studio) Displays a typical print
setup dialog for the report you are about to print.

Merge TAP3 Files ...: Displays a dialog that enables the user to merge two or more TAP3 files of the
same TAP3 release (e.g. 3.10) into a single TAP3 file of the same release. See section Merging
TAP files for more.

Export To: The export sub-menu (enabled only when a file is opened in Roaming Studio) allows the
user to

. Convert a TAP file to another TAP release (Converting TAP files to other TAP versions)
. Convert a TAP file to NRTRDE

. Export a file to XML (Importing / Exporting files from / to XML)

. Remove personal data, i.e. anonymize it (Anonymizing files)

. Export a NRTRDE file to an ASCII format (Exporting NRTRDE files into ASCII).

. Export a file to Excel/CSV (Exporting files to Excel/CSV)

Import From: The import sub-menu allows the user to create a TAP/RAP/NRTRDE file by importing
its data from an XML (Importing / Exporting files from / to XML) based file.

Exit: Asks the user whether to save any modified files and exits the application.

© 2011 Semantix Information Technologies S.A.
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3.1.2 Edit Menu

As shown in the following figure, the Edit menu contains the following menu items and sub-menus:

Edit | Wiewy  Walidations  Configure  Wir

4 Cut byl

=3 Copy Chrl+C

J

>< Delete

.ﬁ_}l Call search ... Ckrl+F

| gplit File Using Last Call Search ...

&% Find ... Chrl+Shift+F

H o Find Mext F3

EIE Replace ... Zkrl+H
Replace Call Dates ... F7
Replace IMSIs ... F&
Go To Call ... Chrl+iE

c-g Templakes ...

The Edit menu

e Undo: Undo last editing action. Roaming Studio supports unlimited undos (to be precise, as many as
there is enough free memory).

e Redo: Redo last editing action
e Cut: Cut an individual field or composite structure and copy it in the clipboard
e Copy: Copy an individual field in the clipboard

e Paste; Paste an individual field or composite structure from the clipboard. Editing and copy-paste or
cut-paste operations are also supported across files — provided of course they are of the same
version (e.g. TAP 3.11).

¢ Delete: Remove an individual field or composite structure without copying it to the clipboard
e Call Search ...: Display the advanced call search dialog and facility (Searching files)

e Split fileusing last call search ...: Create a new file containing only the calls identified in the last call
search (Splitting TAP files)

o Find ...: Display the quick find dialog (Searching files)

e Find Next ...: Allow the user to browse through the calls selected by the last find operation by moving
to the next call (Searching files)

e Replace ...: Replace values throughout the file (Replace)

© 2011 Semantix Information Technologies S.A.
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3.1.3

3.14

Replace Call Dates ...: Replace the DateTime field inside call timestamps throughout the file ()

Replace IMS|s ...: Replace IMSI prefixes inside calls throughout the file ()

Go To Call ...: Allow the user to jump directly to a call specified by its ordinal number in the file

Templates ...: Display the template management dialog that enables the users to create and maintain
template for various TAP/RAP/NRTRDE structures at the call or file level for specific TAP/RAP/
NRTRDE versions (Defining your own templates)

View Menu

The view menu as shown in the figure below consists of four menu items:

Wiewy | Yalidations  Configure  ‘Windou

I *| Toolbar

; E [Daka Dictionary

" Yalidation & Search Results
l Skatus Bar

The View menu

The View menu items toggle on and off the display of the toolbar, the documentation area (Data
Dictionary), the validate and search results area and the status bar.

Validations Menu

The Validations menu is enabled for TAP3 and NRTRDE files and is shown in the following figure:

Yalidations | Configure  Windows  E

| J validate File .. ChrlT

|H_:H, Create Validation Report
x;gj Update Audit Control Info

Shioww Eakal

Show Severe

Show Warnings
Shova Error Balloons

The Validations menu

e Validate File ...: Validates the file (Validating TAP/NRTRDE files)
e Show Next Error: Moves to the next validation error (Validations Results Pane)

e Create Validation Report: Validates the file and generates a report with all the results (Validation
Reports)

© 2011 Semantix Information Technologies S.A.
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e Update Audit Control Info/Update Call Events Count: For TAP files, updates all the Audit Control Info
summary fields re-computing them from the actual call data in the file (irrespectively of any existing
Audit Control Info sums). For NRTRDE files, it updates the Call Events Count field. (Updating
AuditControlinfo)

o Show Fatal: Toggles on and off displaying of fatal errors
e Show Severe: Toggles on and off displaying of severe errors
e Show Warnings: Toggles on and off displaying of warnings

e Show Error Balloons: Toggles on and off displaying of error balloons

3.1.5 Configure Menu

The Configure menu is shown in the following figure:

Configure | Windows — Help

| PrM Reference ...

Countries ...
Currencies ... |

S validation Rules ..

The Configure menu

e PMN Reference ...: Displays the PMN reference data maintenance dialog (Configuring Other
Networks)

e Countries...: Displays the Countries reference data maintenance dialog (Configuring Countries)
e Currencies...: Displays the Currencies reference data maintenance dialog (Configuring Currencies)
e Validation Rules ...: Displays the Validation Rules customization dialog (Overriding Default
Validation Logic)
3.1.6 Windows Menu

The Windows menu (depicted below) contains a set of typical menu items used in all windows MDI
(Multiple Document Interface) applications to control the layout of opened child windows (TAP, RAP
and NRTRDE files in our case).

Windows | Help

Plew Window

(il

Cascade

Tile Mertical

I

Tile Horizontal
Close All

arrange Icons

1 CATAPKIT\SampleDatal3. 10yCODEUD2GRCPF 10000, Full. kap310

The Windows menu
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3.1.7

3.2

Help Menu

The Help menu (depicted in the figure below) contains the following menu items:

e Contents: Navigates to the Help file contents

¢ |ndex: Navigates to the Help file index, allowing the user to search the help file for keywords
e Search: Navigates to the Help file search, allowing the user to search the help file for anything

Help

| Contenkts  Ctrl+F1 |
1.1‘.3 Index
a Search

about ..

WE——

The Help menu.

Toolbars Area

Through the toolbar area, the user can quickly select an action:

E NS H G ] ¥ Ga (& X | I &4 Find v | & |dle |(A)calsearch W | Gotocal
Toolbar buttons

From left to right, the icons are organized in groups and are equivalent to the following menu items:

o File/New

e File/Open

o File/Save

e File/Save All

e Edit/Cut

e Edit/Copy
e Edit/Paste
e Edit/Delete

e Edit/Undo

e Edit/Redo

e Edit/Find
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e Edit/Find Next

e Edit/Replace

e Edit/Call Search
e Edit/Split File Using Last Call Search

e Edit/Go To Call

e Validations/Validate File
e Validations/Create Validation Report
e Validations/Enable Error Balloons

e Validationsg/Update Audit Control Info

3.3 File View Area

The file view area displays the top-to-bottom main structure of the currently opened file:

= [y PatafferChange
=) EransfarBalch
i | bt chiControlInfo
|3 accountingInfo
[ networkInfo
=y calfraniDatair
) 1..1000
) 10012000
) 20013000
) 30014000
) 40015000
) 50016000
) 6001, 7000
) 70087675
| auditContrallnfo

File View area

For TAP3 files, with the exception of callEventDetails, all the nodes directly underneath
transferBatch are file-wide nodes; that is, they contain information about the file as a whole: lookup
tables (for example for taxCodes, recEntityCodes, discountCodes, etc) as well as aggregate
summaries in auditControlinfo (total number of CallEventDetails, etc). callEventDetails instead
collects all the roaming information about the calls made - including the table-referencing codes that
are defined in the file-wide nodes. If the file contains more than 1000 calls, then they are split in groups
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3.4

of 1000 that hung directly under callEventDetails.

As soon as you click on a node containing leaf nodes in the File View (a node NOT displayed in italics
), the selected node appears in the Detail View (Detail View Area)

Detail View Area

The Detail View displays information about any node containing leaf nodes (INTEGERS,
OCTET_STRINGS). It displays information only when a node is selected on the File View area (the
one on its left). It is through the Detail View area that the user actually performs any editing of values

on the tree.

-] I batchControllnfo
=l sender: DELIDE
=] recipient: GRCFF
=] fleSequenceMumber. 10000
=i fileCreationTime5tamp
=] localTimeStamp:  20050307720340
=] utcTimelffset: +0300
=iy transferCutOf T imeStamp
=] localTimeStamp:  20050307720340
=] utcTimelffset: +0300
=i filedwvailableTimeStamp
=] localTimeStamp:  20050307720340
=] utcTimelffset: +0300
of specificatiortersionMurmber. 3
of releaseVersionMumber: 11
£] rapFileSequenceMumber. 03333
=i operatorSpecinformation
=] [1] OperatorSpecinformation:  Test case gz

Detail View area

The user can select nodes either by clicking with the mouse or by navigating through the up/down/
pageUp/pageDown cursor keys.Changing the value of a node is easy: hitting F2 (or Right-clicking and
selecting Edit) shows an edit box allowing the user to change the value. If the node can only take one
of a set of values (according to the validation rules) then the user is also enjoying auto-complete drop-
down combo boxes, like the one below (see also Adding or removing individual fields):
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= | batchControllnfo
SELID
Zl| oELD A
|| DEUD2
17| DEUEL
DEUEZ 002626
DELICZ
DELINF
=] pps

= " 002626
=] utcTimeOffzet: +0700
=43 filedwvailableTimeStannp
=] localTimeStamp: 20030308005143
=] utcTimeOffzet: +0700
of] specificationy/ersionMumber. 3
0f releaseversionMumber 3

Node-aware editing

The values entered must obey the rules of the grammar: entering a string (e.g. "ABC") where an

INTEGER is expected causes an error message.

A similar error occurs if a BCDString (like Imsi) is edited to contain letters (whereas it should only
contain digits). The Data Dictionary (displayed in the Documentation Area) helps by showing you

information about the currently selected element.

Right-Clicking on a node allows the user to save the selected subtree as a template, for later re-use
(see Defining your own templates):

= _’ niEpa e =1
g| imei 4431730363541025
-3 basicServicel sedlist
=] [1] B asicServicellsad
=iy basicService |=3| Copy
-4 servicelog
=] teleSe day Cut
0f radioChan )
0f radioChan >< Delete
o transparen|
—-I—=3 chargelnfarma
=13 [1]Charge w4 Add new element 3
£| chargg
of ewchay
—-|—p calTypelroup
o calTypelevel: 2

Save as template ...

Saving a template for late re-use
Deleting, cut, copy and paste also work as expected.
When a non-existing element is to be inserted, the editor helps by showing exactly what is missing.

Right-clicking on a node and selecting "Add new element” shows a menu with the elements (if any)
that are missing and can be added:
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3.5

= = CED[MabileOriginatedCall]
=i mobileOriginatedCall
=i basicCallnfarmation
-1 chargeableSubscriber
=i simChargeableSubscriber
5 imsi 202052351615036

~ Draka Dictionary

Destination

destmation
Wahdations A5 .1 Parent Types

¢ eslliia o - T Do i sting indicates the mumber dialled b
of tpelft 0y Copy puch as call forwarding or transfer ete.
Eﬂ number Cuk ent containg additional information to
B lledt
Iﬂ =3 :'f' Hon Indicator (conditionally) together
i medific
= IEentSt
o c: IJ-f;Tin K| Delete ete is tmotre than one occurtence of g
:11 teTime Save as template ... Balysis Code must be present to sup
Ao
o t-.:utaIEaIIE VE| w9 Add new element 3
=iy locationlnfarmal
=) networklod
of recEntityCode: 5
o locationdrea: £90 Validat
of celld: 13330
=i equipmentinformation calledPlace 1
of mobileStationClassMark: 3 Error calledReqion |
=i imei0rE sn Code .
=) imei: 3503244528422507 a0 calledhium#AnalysisCode 1

Node-aware addiltioﬁ (;f ch.ildlrlen r;o.dles

As mentioned before, the currently selected node dictates what information appears in the
Documentation Area: as soon as a node is selected, all the relevant information (including the
validation rules for the node) will appear in the Documentation Area.

Documentation Area

As soon as a hode is selected in the Detail View area, the Documentation area is immediately updated
to display all the relevant information from the appropriate TD.57 / TD.35 or TD.32 standard (according
to the file's TAP release number, if it is TAP file, according to TD.35 if it is a NRTRDE file and

according to TD.32 if it is a RAP file):
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Draka Dictionary R X
Sender w
”
sender

Vabidations 451 Parent Types

& urdeue identifier used to determine the
nietwrork which is the Sender of the data.

The full list of codes it use ate given in TADIG
FRD TD.13: PRIN Maming Conventions.

Condifionalify:
Mlandatory within group HMotification.

Mandatory i group Batch Control
Information.

Example confenf:
Lods
GERCHN
GERVF
DEUD]
DEUD:

MNote: These codes must be in wppercase (as
defined in TDVI13),

3 *

Data dictionary - main description

This allows the user to quickly read about what information the node contains as well as how the node
is to be validated.

Furthermore, after the TD information (scrolling down with the scrollbar might be necessary) the
Documentation area displays two grammar-related information lists: the related ASN.1 definitions and
the related ASN.1 Parent Types. Depending on what is being examined (an ASN.1 variable or an
ASN.1 type), either the containing type or the viewed type itself appear in the same way as they are
defined in the ASN.1 grammar:
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ASN.1 Defmition (of containing types)

Motification ::= [APPLICATION 2] SEQUENCE

{
sender Dender OPTICHAL,
recipient Fecipient OPTICHAL,
fileldequencelumber FileZequencelNumber OPTICHAL,
rapFilelequencelNumber FapFilelequencelNumber OPTICHAL,
fileCreationTimeItanp FileCreationTimeItamp OPTICHAL,
filebvailableTime3tamp FilebvailableTime3tamp OPTICHAL,
Lransfercut0ffTime3tammp TransfercutOffTime3tammp OPTICHAL,
specificationVersionMNumber SpecificationVersionbuamber OPTICHAL,
releaseVersionMNunber FeleaseVersionMNunber OPTICHAL,
fileTypelndicator FileTypelIndicator OPTICHAL,
operatordpecInformation OperatordpecInfolist OPTICHAL

B

BatchControlInfo ::= [APPLICATICN 4] SEQUENCE

{
sender Sender OPTICHAL,
recipient Fecipient OPTICHAL,
fileldequencelumber FileJequencelumber OPTICHAL,
fileCreationTime3tanp FileCreationTimeItamp OPTICHAL,
Lransfercut0ffTime3tammp TransfercutOffTime3tammp OPTICHAL,
filebvailableTime3tamp FilebvailableTime3tamp OPTICHAL,
specificationVersionNumber SpecificationVersionbumber OFPTIONLL,
relegaseVersionunber FeleaseVersionMNunmber OPTICHAL,
fileTypelndicator FileTypelIndicator OPTICHAL,
rapFilelequencelumber FapFileJequencelumber OPTICHAL,
operatordpecInformation DperatordpecInfolist OPTICHAL

Parent Types

EatchControlInfo
Notification

Text extracted from G3ML TDS7 standard

Data dictionary - grammar definitions when variable 'sender’ is selected
Additionaly, the parent types for the selected element appear at the bottom.

In the example above, the Documentation area shows the two "containing" types for variable "sender".
In addition, all the related variables and types are hyperlinked to each other, allowing easy navigation
in the TAP/RAP/NRTRDE grammar of the selected file. Notice that this is different from navigating the
actual tree from the File View and the Detail View areas; the grammar navigation shows the user what
the tree is allowed to contain - whereas the File and Detail area show what the file contains - nothing
more.

Also notice that the unique identifier of a node is its variable name, not its type name. For example, in
a TAP 3.10 file, there is a different validation ruleset for variable fixedDiscountValue:
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[Daka Dickionary

| DiscountRate

Falues: Q00 thrw 10000

Validations

] Aectng Fatal  Swyntax error.

20 &ectng Fatal = Walue out of range.

ASN. 1 Defmition (of containing types)

{

Digscountipplied ::i= CHOICE
fixedDiscountiValue DiscountWValue,
discountRate DiscountRate

"fixedDiscountValue" variable validations

29

...and a completely different one for its type, DiscountValue (notice the additional error code, 22):
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Validations

Error | Context |Severity |Validation Description

Coie Level
10 Calls Severe  Jyntav error.
20 Calls severe  Value out of range.
22 Calls Severe  Where the associated Discount Code relates to
a Discount Rate, the Discount Value does not
cottespond to the Charge and Discount Fate
(note that rounding niles are at the discretion of
the Sended).
ASN.1 Defiation
DiscountWalue ::= [APPLICATION 93] Absolutelmount
Parent Types
Discountipplied
DiscountInformation
W
Mear+  —ard it —r] e WA TTE™ 4 —anlmae A

"DiscountValue" type validations

It is therefore advised to always use the variable names when navigating the Documentation area.

3.6 Validations and Call Search Area

After a validation is performed, the validation area reports any errors found (see Validating TAP/
NRTRDE files):

|@ Fatal

1_:1 Severe | & YWarnings | a Mezxt Errar

Element Error Code Severity Q... Descripkion
Zall Event Details Caunt 100 Fakal 1 Yalue does nok |
Total Charge 100 Fakal 1 Yalue does nok |
Takal Discount Yalue 100 Fakal 1 Yalue does nak |
Total Tax Yalue 100 Fatal 1 Yalue does not |
<

Yalidation resulks | Call search resulks

Navigating validation errors
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Clicking on "Next Error" (or hitting F4) navigates to the next instance (in the TAP or NRTRDE tree) of
the selected categories of errors.

The same area is also hosting the Call search results, in the adjacent pane, after a call search (see
Searching files):

Zall Type Zall Index
mobileCriginatedCall 7
mobileCriginatedCall a
mobileCriginatedCall a
mobileCriginatedCall 10
mobileCriginatedCall 13
mobileCriginatedCall 14
mobileCriginatedCall 15
mobileCriginatedCall 16

Yalidation results | Call search results

Navigating Call search results

Double clicking on one of the result lines navigates to the call in question.
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4

Viewing and Browsing files

When you first open Roaming Studio no file is loaded (as depicted in the figure below):

£ Semantix Roaming Studio

Eile  Edit  Wew  Configure  Windows  Help

P e o

Ready

Roaming Studio with no file loaded

You select a file to open using the Filez Open ... menu which displays a standard Windows file dialog
allowing you to choose a TAP/RAP/NRTRDE file to open. Since Roaming Studio is an MDI (Multiple
Document Interface) application you can have many TAP/RAP/NRTRDE files simultaneously open
controlling their layout through the standard menu items in the Window menu as depicted in the figure
below.
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¥ Semantix Roaming Studio

File Edt Wiew Valdations Configure  Windows  Help

ilj = W= NEREENE ¢ | €] i 84 Find ﬂ; | ale |@CaIISearch | Jump to call

|£5) accountingInfo

|05) networkInfo

|5) vwasInfo

{EJ messageDescriptionInfo
209 calfventDetalr
: ! R
“I3) auditControlinfa

= | batchContralinfa
T e D2
recipient: GRCPF
fileSequanceMumber 10000
-5 fileCreationTimeStamp
i <= lecalTimeStamp: 200503071
<2 weTimelffzet: +0300
=123 transterCutOHT imeStamp
localTimeStamp: 200503071
=1 wtcTimeDffzet, +0300
) filetwailableTimeStamp
o2 localTimeStarmp: 200503071

 Data Dictionar
| i

| Sender

Sender
Validations ASM.1 Parent Types
& unigue identifier used to

determine the network which is the

Sender of the data.

The full list of codes in use are
giwen in TADIG PRD TD.13: PMM

uteTime0 ffzet: +0300
[of] specificationy'srsionM umber: - 3 = s

MNaming Conventions,

3 relosectfarsinehlirmhar 72 A
|® Fatal | (1) Severe |||_1\. Warnings || Mezt Errar

Error Code

Element Severity Description

4

Yalidation results | Call search resules

Ready

Roaming Studio is an MDI application

The currently selected file window in the Roaming Studio (you can select another already opened TAP,
RAP or NRTRDE file any time using the Windows menu) is displayed in the manner depicted in the
figure below. To reproduce this example open some sample files provided in the TD57_TestCases
folder which you can find in your installation folder (x:\Program Files\Semantix\Semantix Roaming

Studio\TD57_TestCases).

Windows | Help

"fj e Window
% Cascade

Tile Yertical
= Tile Horizontal
Close &l

Arrange Icons

1 C:\Program Files\SemantixSemantix Roaming Studio\TDS7_TestCases)| TAP3, 03\ DDEUDZGR.CPF10000. AccessPaointMame_10
2 C:\Program FilesiSemantix\Semanti: Roaming Skudiol TDS7_TestCases| TP, 03 CDDEUD2GRCPF 10000, BasicService_31
3 C:\Program FilesiSemantixSemantix: Roaming Skudiol TDS7_TestCases\TAPS. 0N CODEUD2GRCPF 10000, AirInterfacellserR ateRequested_10

Main display areas for an opened TAP file in the Roaming Studio environment

As you can see in the figure above there are two main file data display areas: the high level display
area and the detail display area. The rest of your screen area is occupied by the documentation (data
dictionary) area, the validation and call search results area and the various toolbars, menu and status
bars. For the purpose of this Chapter we will describe the high level display area, the detail display
area and the documentation area. It is important to notice that for the most part, these three areas
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move in tandem: i.e. when you click with your mouse a certain point in the high level display area, both
the detail display area and the documentation area might (and probably will) change.

The purpose of the high level display area is to give you to a single window access to all the basic
parts and structures in the TAP/RAP/NRTRDE file. It provides therefore a bird’s eye view of the file
and is used for high-level navigating in the TAP/RAP/NRTRDE file and not for viewing individual fields
and structures. Viewing and editing individual fields is done at the detail display area.

Take a look at the high level display area pictured in the figure below.

- |3 Lafainéerihange
- fransferBatch
] batchControllnfo
[ accountingInfo
[ metworkInfo
[ wasInfo
[ messagelescriptionInfo
—-i ) caffveniDetads
=89 1.8
[ [1] CEDMobileCriginatedCall)
[ [2] CED(Mobile TerminatedCall)
[ [3] CEDSupplServiceEwent)
[ [4] CED(ServiceCentrellsage)
[ [5] CEDValueaddedservice)
[ [6] CEDGprsCall)
[ [F] CEDContent Transackion )
[ [B] CEDMLocationService)
[ auditControlInfo

High level display area for a sample file

If you are familiar with the internal structure of a TAP/RAP/NRTRDE file you will immediately recognize
the nodes and structures displayed there. Note that a TAP/RAP/NRTRDE file is, technically speaking,
a tree-like data structure stored in a file. Therefore the design of both the high level display area and
the detail display area reflect that fact by using tree controls to display the arrangement of the various
data structures in a TAP/RAP/NRTRDE file. You can even consider, if you find this helpful that the
high-level display and the detail display areas cut through the entire tree of data structures in half as
depicted in the figure below. The high level area displays the upper part and the detail area the lower
parts.
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= | DafainierChange
=) fransferfalch
|5 batchControlInfo
(@] 2coountingInfo
I networkInfo
|2 wasInfao
| messageDescriptionInfo
= cadfveniDetaie
203 1.8
5 [1] CED{MabileCriginatedCall)
) [2] CED{MabileTerrminatedCall)
) [3] CED{SupplaerviceEvent)
) [4] CED{Serviceentrellsage)
) [5]1 CED{YalueAddedService)
) [6] CED{GprsCally
() [7] CED{ ContentTransaction)
[ [8] CED{LocationService)
| auditControllnfo

= | accountinglnfo
=) taxation
=13 [1] Taxation
(2 t==Code: O
=] taxType: 13

=] tawRate: 1000000
=i dizcounting
=i [1] Dizcounting
0f dizcountCode: 0
=15 dizcountépplied
0f discountRate: 1
=) localCurency: ELIR
=3 cumencyConversioninto
=i [1] CurrencyCorversion
i ewchangeRateCode: 0
0 numberQf0ecimalFlaces: 5
0f exchangeRate: 126653
0| tapDecimalPlaces: 3

The high level and the detail areas display different parts of the TAP tree

But let’s get back to the high level display area. The names of the various nodes in the tree display are
those found in the file-related specification: TD.57 for TAP, TD.32 for RAP and TD.35 for NRTRDE. To
be more precise the names are derived from the ASN.1 grammar that is included as an appendix of
each document. Both the high level display area and the detail display area use the field member
names and not the field type names that are found in the ASN.1 grammar as it is these names that
allow one to unambiguously identify a given field or node in the file. So for instance you have field
“accountingInfo” (name of member field) and not “Accountinginfo” (hame of member type). The same
convention also applies to the detail display area. The SEQUENCE_OF nodes constitute an exception
to this convention, since there is no variable name to use for each element of the sequence and thus,
type names are necessarily used (see "[1] Discounting" in the previous example). Back at the high-
level display area, the top of the tree (the “root” in technical data structure parlance) is named after its
type “DatalnterChange”. This is the only other exception to the "variable name" convention, due to the
fact that the root of the tree is the outermost node and as such it is not a member field in any node so
its type name is the only name that can be used.

In both the high level and the detail area we chose the names found in the ASN.1 grammar definition
(e.g. “accountingInfo”) over the names used in the data dictionary descriptions (e.g. “Accounting
Information”) and the rest of the TD.57 document as the ASN.1 grammar is more appropriately used
as a reference. The above distinction may be driving too fine a point as the names adopted in this
manner are almost identical in all cases with the human-readable names that appear in the data
dictionary minus the spaces. For instance, we can'’t think of any case where a TAP-literate user might
be at a loss as to what field “networkInfo” is, assuming he understands what “Network Information” is.
Even if this happens, the data dictionary (sitting right next to the Detail View area) shows the relevant
TD.57/TD.35/TD.32 section, so it is literally impossible to miss-identify an element.

Regarding the high level display area there is another convention you should know about. The idea is
that the node or structure selected in the high level display is displayed in detail in the detail display
area. However only nodes for which it makes sense to display them in the detail display area, are
displayed there. What exactly does this mean? Recall that the purpose of the high level display area is
to allow for quick navigation throughout the file and that the purpose of the detail display area is to
display individual fields and values and allow the user to edit them. Therefore only nodes that directly
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carry a value field get displayed in the detail display area. Nodes that only carry other composite nodes
don't have a detail view and are displayed in italics to signify that. This is why you have “transferBatch”
in italics but not “batchControlinfo”. The “Transfer Batch” node carries only other subordinate
composite nodes and no final “leaf’ value whereas the “Batch Control Info” node carries at least some
final “leaf” values like Sender and Recipient (in addition to subordinate composite nodes it itself carries
like fileCreationTimeStamp and operatorSpecinformation).

Finally in order to allow easier navigation in large files, calls are grouped in thousands (in the case of
large files). You have to use the mouse pointer to expand each batch of thousand calls and then select
an individual call before that call's contents are displayed in the detail view area as in the figure below.

E Semantix Roaming Studio - [C:\TAPKIT\SampleData\3.4\cdcypctgrcpf02527]

ol Fle Edit Wew Walidations Configure  Windows  Help - 2 X
‘i == N J ¥ Ea ;X | J 33 Find - d\é) | afe |@CaIISearch kY |Jumpt0call J =] @;‘73]
o ) Datadnterchange = 125 CED[MobileOriginatedCall] # | i Data Dictionary S
=) transferPatch =+ mobile0riginatedCal
|C5) batchContrallnfo =3 basicCallnformation Imsi M
|3 accountingInfo =) chargeableSubscriber . o
I networkInfo =i simChargeableSubscrber Imsi
25 cafEveniDetair = B Walidations ASN.1 Parent Types
®-) L. T008 . %1 .msisdn: 30944335517 The identifier which uniguely
) 1001 1942 : ) = destination identifies the subscriber who
D [IDDI]CED(Mob!IeTerm!natedCaII) ] typeDfNumber: I has used the network and is
I [1002] CED{MobileTerminatedZall) of numberingFlar: 0 lisble for any charges that may
I [1003] CED{MobileTerminatedCall) =] calledMumber. 03034273000 be incurred.
(= calEventStartTimeStamp i e
o0 2 localTimeStanp: 2002015231506 || DErvatens
I5) [1006] CED{MobileCriginatedCall) 03 utcTimeDffsetCode: 1 GSM item servedIMSI
I [1007] CED{MobileTerminatedall) 0] totalCallEventDuration: 0 (GSM 12.05).
I [1008] CED{MobileTerminatedCall) =3 locationinformation Conditionality!
I [1009] CED{MobileTerminatedZall) =+ networkLocation T
: ) : Mandatory within group
1010] CED{MobileT bedCall 0. EntityCode: 2 :
=] ! (MobileTerminatedCall) d); rectniyLode Chargeable  Subscriber

I3 [1011] CED{MabileOriginatedCally
I [1012] CED{MobileCriginatedCally
I [1013] CED{MobileTerminatedCall)
10 [1014] CED{MobileCriginatedCally
I [1015] CED{MobileTerminatedall)
I [1018] CED{MobileCriginatedCally
I [1017] CED{MobileTerminatedall)
I [1018] CED{MobileTerminatedCall)
10 [1019] CED{MobileCriginatedCally
I [1020] CED{MobileTerminatedCall)
I [1021] CED{MobileTerminatedZall)
1) [1022] CED{MobileTerminatedCall)
I [1023] CED{MobileTerminatedCall)
I [1024] CED{MobileTerminatedCall)
I [1025] CED{MobileCriginatedCally
I [1026] CED{MobileCriginatedCally
1) [1027] CED{MobileTerminatedCall)
I [1028] CED{MobileOriginatedCally
1 [1029] CED{MobileCriginatedCall)
I [1030] CED{MobileOriginatedCally
I [1031] CED{MobileCriginatedCally
1) [1032] CED{MobileTerminatedCall)
I [1033] CED{MobileTerminatedall)
10 [1034] CED{MobileCriginatedCally
I3 [1035] CED{MobileTerminatedall)
I [1038] CED{MobileTerminatedZall)
1) [1037] CED{MobileTerminatedCall)

. C4020 1 CEC R bl T e, obm e 1y

Ready

0 locationdrea: 41
=i equipmentinformation
=i imeilEsn
=) imei; 520031510752850
=) bazicServicel sedlist
=i [1] BasicServicellzed
=i basicService
= erviceCode
=) teleServiceCode: 22
=\ chargelnformationList
=i [1] Chargelnformation

when MIN not present,

Must be present within
group G5M Chargeable
Subscriber when
available,

|pefined in 75 Gom 05.03

Validations

=) chargediter: E .
o) exchangeRateCode: 1 Error|Context|Severity|Val
29 callTypeGroup Code Level |Des
i) callTypelevell: 1 10 calls Severe Syn
i) callTypelevel2: 1 .
0f] callTypelevel: 1 < N
(=) chargeDetaillist hd
I |® Fatal |||l‘:) Sewvere |||_L Warnings || ﬂ Iext Error
Element Error Code Severity e, Description
< ¥

Walidation results | Call search results

Expanding a thousand calls batch and selecting an individual call

Moreover, you can use the high level display area’s vertical toolbar to scroll through large files or
expand / collapse any structure to conserve on the vertical deployment of the file's data.

This concludes our description for viewing and browsing a file in the high-level display area. As noted
above, the high-level display area, the detail display area and the documentation area move in tandem
so selecting a structure or field in one area will also affect the others.
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The detail display area is used to display the contents of a particular structure that is selected in the
high level display are. So when a different structure is selected in the high level display area, the
contents of the detail display area will also change. Structures depicted in the detail display area will be
either calls as in this figure that depicts a Mobile Originated Call ...

= |3 CED[MoabilOriginatedCall] ”
=i mobilz0riginatedCal
=43 bazicCallnfarmation
—-{—3 chargeableSubscriber
=3 simChargeableSubscriber
=] imsi: 202052951535246
=] msisdr: 30344335517
=|-{—3 destination
of] typeOfNumber: O
if] numberingPlan: 0
=] calledMumber: 03034213000
=i calEventStartTimeStamp
=] localTimeStamp: 20020119231506
if] utcTimelffsetCode: 1
of totalCallE ventDuration: 0
=43 lecationlnformation
=i networklocation
of recEntityCode: 2
of] locationdrea: 41
- equipmentlnformation
=iy imeidEsn
£] imei 520031510752350
--i basicServicelsedlist
=i [1] BasicServicelsed
=i basicService
- serviceCode
=] teleServiceCode: 22
—-i— chargelnformationList
—-i=3 [1] Chargelnformation
=0 charged|ter; E
0f] exchangeRateCode: 1
=i calTypelGroup
of callTypelevell: 1
of callTypelevel2: 1
of callTypelevel3: 1
=i chargeDetailList
=i [1] Chargelietai
=] chargeType: 00
o0f charge: 50
=] dayCategory: |
=] timeBand: |
=i taxnformation
=i [1] Taxlnformation
of tawCode: 1
of tadalue: O

% _mnarsbarS naclsbares sbice

A Mobile Originated Call displayed in the detail display area
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... or other file-level structures with at least one “leaf” as in this figure that depicts a Network Info
structure.

=1 I netwarklmfo
=i utcTime0ffzetinfo
=i 1] UteTimel fsetD efinition
utcTimeO ffzetCode: 1

=] uteTimeDffset: +0200
= [2] UteTimel fsetD efinition
o uteTimeOffsetCode: 2
=] uteTimeDffset: +0300
=i recEntitylnfo
=i [1] RecEntityD efinition
of recEntityCode: 1
of recEntityType: 1
=i recEntitpld
=] msizdn: 35739503933
=i [2] RecEntityD efinition
of recEntityCode: 2
of recEntityType: 1
=i recEntitpld
=] msizdn: 35739505933
=i [3] RecEntityD efinition
of recEntityCode: 3
of recEntityType: 1
=i recEntitpld
=) maisdn: 35733504333
=i [4] RecEntityD efinition
of recEntityCode: 4
of recEntityType: 1
=i recEntitpld
=) maisdn: 35733501333
=i [5] RecEntityD efinition
of recEntityCode: 5
of recEntityType: 1
=i recEntitpld
=) maisdn: 35733502333
of networkType: 1
=iy calledHuméanalysis
=i [1] CalledMumanalyzis
=i countryCodeT able
=] 1] CountryCode: 357
=iy 1acT able
=] M]lac:00

The Network Info file-level structure displayed in the detail display area

Note that as already indicated structures that contain only composite substructures and thus no “leaf”
fields do not get displayed in the detail display area and are indicated in italics in the high level display
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area (e.g. the Transfer Batch structure).

In the detail display area the user can view and edit individual fields. Editing is done as you might
expect: by double-clicking on any individual field (or hitting F2) and typing in a new value. In so far as
viewing is concerned, you can use the detail display area’s vertical toolbar to scroll through the
information or expand / collapse any structure or sub-tree in the detail display view to fit what you want
to view in one window without needing to resort to the toolbar (just like the high level display area).

Finally, the documentation or data dictionary display area automatically displays the relevant passage
from the reference data dictionary information of the appropriate TD.57/TD.35/TD.32 standard
(depending on the file’s format) as seen in the figure below. The information displayed there is HTML-
ized allowing the user to easily browse the documentation in the relevant TD.57/TD.32/TD.35 standard
for the TAP/RAP/NRTRDE file in question (see more in Documentation Area).

= [ CED[MuobileTeminatedCall]
== mobileT erminatedCall
=15 basicCallnformation
=-I) chargeable5ubscriber
=5 simChargeableSubscriber
=) imsic 202053052279204
=\ msisdr: 30342637588
=i calOriginatar
i type0fMumber: 0
o] numberingPlan: 0
=] calingNumber: 002034273000
=) calEventStartTimeStamp
=] localTimeStamp: 20020173231248
of utcTime0HsetCode: 1
0 totalCallE ventDuration: 0
=i locationlnformation
=5 nebworkLocation
| recEntityCode: 1
0y locationfrea 21
=43 equipmentinformation
= imei0Esn
= imei 350534803607220
=3 basicServicel sedlist
=i [1]BasicServicelsed
=3 basicService
=i serviceCode
Ef teleServiceCade: 21
=3 chargelnformationList
=3 [1] Chargelnfarmation
=| chargeditem: E
0y exchangeRateCode: 1
=3 chargeD etailist
=3 [1] ChargeDetail
=) chargeType: 00
of charge: 0
=] dayCategaory: |
=) timeBand: |
=13 operators peclinformation
=) [1]OperatorSpecinformation:  CYTASM: 0082632

Data Dictionary o x
TeleServiceZode v
TeleServiceCode b

Validations ASM.1 Parent Types

& code which uniquely defines a TeleService.

Group TeleService Codes, identifiable by the description ‘all’,
should only be used where details of the specific services
affected are not available from the network,

Mote that compound TeleService group codes can only
occur in call independent supplementary service operations.

Derivation:
GSM item TeleServiceCode {GSM 12.05).

The code is derived by taking the MAP encoding
{GSM TS 09.02) and translating bits 8-5 into a 'hex'
character and bhits 4-1 into a second ‘hex'
character.

Conditionality:

Must be present within group Service Code where
the type of service used was a teleservice. Must
not be present when the type of service used was
a bearer service and, therefore, Bearer Service
Code is present.

Values:

o0 All teleservices

18 Speech

11 Telsphony

12 Emergency calls

20 All SMS Services

21 Short Message MT/PE

22 Short Message MO/LE

31 Advanced MHS access

41 Videotex access profie

42 \ideotex access profile 2

43 \ideotex access profile 3

51 Telatex (Clrowit Switch)

52 Teletex (Packet Switch)

o0 All Fax Services

51 Facsimile Group 3 & alternative speech
&2 Automatic Facsimile Group 3

S A ke mim e e e

< b4

The data dictionary display area automatically displays the relevant information depending on the selected field
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Searching files

Roaming Studio provides two ways to search in TAP/RAP/NRTRDE files: the advanced call search
facility and the quick search facility. An important distinction to always bear in mind is that the
advanced call search facility is a call-level search whereas the quick search facility is a field level
search. What this means is that the results of the advanced call search facility is a list of selected calls
(as opposed to specific fields inside each call) whereas the results of the quick search facility are field
specific. So, when looping through the results of an advanced call search (see below) you are looping
through calls visiting each call that matches the search criteria once whereas when looping through the
results of the quick search facility you are looping through fields possibly visiting more than one field
inside each call.

You can perform an advanced call search in three ways:

e by pressing CTRL+F

e by selecting Edit: Call Search ... from the menu

¢ by clicking on the Call Search button on the Search & Replace toolbar

The advanced call search facility dialog (depicted below) allows you to restrict your search to specific
categories of calls (e.g. Mobile Originated Calls or GPRS calls) and to specific call indexes (e.g.
between calls #100 and #200). It also allows you to examine and test in your search the value of every
field you select in the file using a set of standard operators. The operators depend on the data type of
the field selected and include, among others, “contains”, “is empty”, “exists”, “equals”, “is less

than” (and their complementary negative operators). Using the advanced call search facility you can
also create composite queries by combing simpler queries with Boolean expressions (any of the rules /

all of the rules).

The advanced call search facility

As an example, we will search for Mobile Originated calls or GPRS calls whose charge exceeds 499 or
whose duration exceeds 99. The following figure depicts the advanced call search dialog for this
search. Since the file we are searching has 1723 calls, the dialog upon opening has already filled the
call index boundaries with 1 and 1723. We only fill in the rest of the details:
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Call search g|
Call types
| [7] MobileOriginatedCall [ MobileT eminatedCal [ Selectan] [ Cearal |
[] SupplServiceE vent [] ServiceCentrellzage [
[] YaluerddedService GprzCall | o =
ContentT ransaction LocationService (B =
O O | to call index
11723 =
Define more criteria
Field Condition " alue
| tatalZallE ventD Lration W | iz at least w | (100
&dd New Rule © Match al
Fules (%) Match any
| Field Condition Value '
| charge iz at least 500
totalCallE ventDuration iz at least 100
ak. l [ Cancel ] [ Ewxport Query oL .

An example of an advanced search

After adding the search rule (pressing the "Add New Rule" button) and then pressing the ok button, the
search will be performed and the identified calls will appear in the Call Search Results pane of the
Validations and Call Search area as depicted in the figure below.

Call Type Zall Index ~
mobileCriginatedCall 31

miobileCriginatedCall 36

miohileCriginatedCall 117

miohileCriginatedCall 164

robileCriginatedCal 166

robileCriginatedCal 177

robileCriginatedCall 135

miobileCriginatedCall 201 2
revm il s vimim s ke A s rlaics

Validation results | Call search resulks

Calls selected by the last search appear in the call search results pane

You can then loop through the selected calls by pressing F3 or by directly double-clicking at a specific
call index result in the Call Search Results pane.

Sometimes though you just need to perform a quick-and-dirty search for a given string or number and
find all of its occurrences in the file irrespectively of the field. The quick find search was implemented
for this purpose.

You can perform a quick find search in the following ways:

e By pressing CTRL+SHI FT+F
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¢ By selecting Edit< Find from the menu
¢ By using the Find button on the toolbar

Pressing the CTRL+SHI FT+F keys, selecting the Edit++ Find command from the menu or clicking on
the Find button on the toolbar display the Find dialog depicted in the figure below.

Find ]

Find */hat;

gearch for

[] Match case () Field Walues
[] Match whale word {3 Field Keys
(%) Both values & keys

The Find dialog

Using this dialog the user has the option to perform a case sensitive or insensitive search for a full
string or a sub-string in the field names or field values of a file. Note that the find dialog can also be
used to find field names (as opposed to field values) or both field names and values when the Values &
Keys radio box is selected.

You can also use the text box next to the Find button on the toolbar to enter a new value and press
enter to perform a new search (with the last quick find settings and the new value).

As in the case of the advanced call search, pressing the F3 key or clicking on the Find Next button on
the toolbar will allow you to loop through all selected fields. However, a find operation won't display its
results in the Call Search Results pane of the Validations and Search area — this pane is used to hold the
results of the last call search only.
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Replace

Choosing "Edit/Replace" from the menu, hitting Ctrl-H on the keyboard, or clicking on the Replace icon

of the toolbar shows the "Search and Replace" dialog:

Search and replace

(%)
Find *hat:
el
e J
Condition Qld* alue -
_H eplace Al

| iz lezz than W | | a0 |
Feplace with
MHew W alue Cloze
a0

'

Search and Replace dialog

This dialog allows the experienced user to search for all instances of an ASN.1 node that fulfill simple
search criteria and change their values. This can be done automatically (by clicking on "Replace All")
or manually (by clicking on "Find Next", "Replace", "Find Next", etc). In the example shown above, the
operator decided to increase their revenue by searching for all "charge" nodes containing values less

than 30 and setting them to 30.

The manual search/replace mode is useful when you want to be sure you are not changing something
you don't want to; each time "Find Next" is pushed, the Detail View Area is updated to show the
relevant part of the tree containing the located node. This way, the user can verify that he/she indeed

wants to change that particular instance of the node:
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eData\3. ACDDEUD2GRCPF13110. fake. 3. 9]

dows  Help
1d | v|-§§,|a]ze |@Call5&arch W | Gotocal | = [H_E\.?) FE |
[0 totalCallE ventDurpk—
=9 locationinformation search and replace &
E&} nEtWDrlELDFagDE Find "what
e 0] reck nbityCodg .
0 locationdrea: el
of cellc 25311| | charge
=10 equipment! nformationy -
- Condit Qld ¥l
“o5f mobileStationClag _Dn men i Replace Al
=7 basicServicel sedlis |'S less than vl |3EI |
=155 ] BasicServicel
=/ basicService Replace with
: EI@ serviceld  Newalue Close
LR E] teles a0 |
o e e
|03 radicCha
-8 transparefcHnEator T = || intemnal market bilateral agreements, see TAP
B- ; chargelnfnrmatlnnLlst. Currency.
EI@ [1] Chargelnformation Erample:
i[Z] chargeditem: E b eall of 7 minutes duratios i
- h P ateCods: 1 call o mitmtes duration is
Elg E;Zr a:[?:ta'ic_llL?stD ® charged at 1 3DE per 30 seconds;
= [?I'] o e the call is liable for tax at 15% and
e o S | | the HPMN will get the call
i |§1 Charge | Ppe: diarmintad at N% 1
: [ IS il | >
1] —
Ype Call Indesx ~
s0riginatedCall 7 -
s0riginatedCall g
s0riginatedCall E
soriginatedCall 10
s0riginatedCall 13
s0riginatedCall 14
s0riginatedCall 15 w
stion resulks | Call search results

Manual search/replace
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Replace call dates

Choosing "Edit/Replace call dates..." from the menu or hitting F7 on the keyboard shows the "Replace

dates in calls" dialog:

Replace dates in calls

3

Qld date

| 2009/11/04 5|
Mew date
| 2009411/04 s [ oob

]

Replaces call dates dialog

This dialog allows the experienced user to search inside all calls and replace ONLY the date part in all
timestamps (e.g. CallEventStartTimeStamp, ChargingTimeStamp, etc) from an old date to a new

date.
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Replace IMSIs

Choosing "Edit/Replace IMSIs..." from the menu or hitting F8 on the keyboard shows the "Replace
IMSIs" dialog:

Replace [M5ls in calls

Old IM5SI prefix | Eieplace &l

i,

20205

Cloze
Mew IMS] prefis
20204 | Help

Replace IMSIs dialog

This dialog allows the experienced user to search inside all calls and replace ONLY the prefix part of
the "Imsi" field. When the "Replace All" button is pressed, any call's "Imsi" field that starts with the
specified "Old prefix" will be updated to use the "New IMSI prefix".
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Validating TAP/NRTRDE files

Validating a TAP/NRTRDE file refers to the process of checking it against the data dictionary validation
rules of the appropriate TD.57/TD.35 specification.

You can validate a file by:
e Choosing Validations® Validate File from the menu
e Pressing CTRL+T

¢ Clicking on the Validate File button on the toolbar

Invariably, the Validation window appears with a progress bar to monitor the progress of the validation
process (it can take a few seconds on large files). Note also that it is possible to manually override the
validation process by configuring your own validation profile. Validation profiles allow you to change the
severity of various validation errors (e.g. from “severe” to “warning”) or to change the ranges or value
sets that specific validations check for. Validation profiles are examined in Overriding Default
Validation Logic.

Once validation is completed the Validation window looks like the one depicted in the figure below (for
TAP files):

File Validation [X|

Frogress

[IIIIIIIIIIIIIIIIIllllllllllllllll]

File statuz

Fatal Errars: 1
Severa Emors: a
W arnings: 1]

[ verren ]
[ Frune ermoneous calls ]

[ Create RAP ]

The validation window

The completion of the validation process has four visible / actionable results:

¢ the file's high level view area and the detail view area are re-painted to reflect fatal, severe errors
and warnings

the user is given the option to create a validation report

the user is given the option to prune erroneous calls (if any severe errors exist)

the user is given the option to create a RAP file with the validation errors (for TAP file validation)

the Validation Results pane of the Validate and Search area now contains the validation results
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allowing the user to navigate through them

These are detailed in the sections that follow.

9.1 Re-painting of the File and Detail View Areas

Once validation of a file is completed, the file's display in the high level and detail view areas is re-
drawn. Wavy underlines are drawn below any field or call or structure (call-level or file-level) for which
a fatal or severe error or a warning has been identified. Fatal errors and severe errors are indicated
with a red wavy underline whereas warnings are indicated with a green wavy underline. By hovering
your mouse pointer above any field that is underlined in this manner a balloon description of the
validation error will appear (assuming of course that error balloons are enabled in the Validations:
Show Error Balloons menu item).

Sl CED|GiprsCall # | i Data Dictionary
=i~ gprsCall
of typelfControlingtode: 1 CallEventDetail
-1 gprsB asicCallnformation , .
=-|= chargeableSubscriber CallEventDetail
=i chargeableSubscriber Walidations A5H.1 Parent Topes

=i simChargeableSubscrber
=\ imsi: 202052951745654

of pdpType: 2

=y ppbddress: 10.211.14 ASN.1 Defition
=i gprsDestination

= acce intMameMl; internet CallEwventhetail = CHOTIC
=i calEwve

I, Warning

£ locd
o utcT| - GPRS Destination 31 (Warning) Mandatory item Access Point Marme CT missing within
of totalCallj  9roup.
of chargin
-1 gprsLocationinfomation walue lddedoervice
=i gprshetworklocation gpr=sCall
=iy recEntiy contentTransaction
of [1]RecEntityCode: 0 E

of] [2] RecEntityCods: 1

Validation messages appear when hovering the mouse over underlined nodes

You can also control which types of validation errors (fatal, severe errors or warnings) are indicated
with wavy lines by enabling or disabling the Show Fatal, Show Severe and Show Warnings menu items
in the VValidations menu. Double-clicking on a specific error class listed in the tabular listing of the
Validation results pane (see Section Validations Results Pane) or checking / un-checking the tick box on
its left allows you to also exercise a much finer level of control by deciding which specific error cases
will be identified visually with the wavy underlines. Note that enabling or disabling the Show Fatal, Show
Severe and Show Warnings menu items of the Validations menu or toggling on and off specific error
classes in the Validation results pane has another important effect beyond the painting of the wavy lines:
it controls error eligibility for the F4 loop (see Section Validations Results Pane for more).
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9.2

Validation Reports

By pressing the View Report button on the Validation window a validation report is created as an RTF file
and is opened as a separate document in the Roaming Studio MDI application using a built-in RTF
viewer. An example TAP3 Validation report is depicted in the figure below:
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£ Semantix Roaming Studio - [Validation Report :C:\TAPKIT\SampleData\3.4\cdcyp... g@g|
- O X

o=l File Edit Yiew Configure  Windows  Help

L0 5

Validation Report

(Genarated by SEMANTIY Boaming Componenis, on Mon Jun 26 14:46:37 2008)

1. General Information

File Hatme:
Sender: CYPCT, Crytamobile-Vodafone
Recipient: GRCPE, wodafone
Seguence Number: 02527
TAFP Version: TAF 34
Status: SEVERE ERRFORS
2. Summary
Record Type Valid Vrrvadid Vaiid Revenue  VFrvalid Revenue
IO bE3d 13 B5.70 5,65
LITC il 1 .00 .00
BeE 1 1 .00 .00
RO 1 1 .00 .00
[FAS 1 1 .00 .00
IGFPES 1 1 .00 .00
Content Transaction [ 1 .00 .00
[ocation Services 1 1 .00 .00
piudit Control Info 1 1

Total calls 1442

Total revenue 10444

Total warnings 0

Total severe 1 (revenue lost is 8.65)

Total fatal 0
2. Error Datails
Severe 20 [Call Type Lewel 3], oceours 13 timeSs

Value out of range.

End of Report

Ready

A typical validation report RTF file opened inside the Roaming Studio MDI application

Most of the Roaming Studio menu items and toolbars are disabled when a report is the top level
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9.3

window whereas some menu commands that were previously disabled are now enabled allowing you
to print preview (File® Print Preview ...), setup (File= Print Setup ...) and print the report (File< Print
...). Of course you can also save it as an RTF file (File?: Saveand File#: Save As ...). Finally, to go
back to the file you were validating you can either close the validation report window or switch to the
file window from the Windows menu.

Pruning Erroneous Calls

Assuming that a file is being validated and at least one or more calls with a severe error were found,
the user will be given the option to prune these calls out of the file. The user is given this option as the
Prune erroneous calls button on the Validation window gets enabled when there is at least one severe
call.

TAP Validation [X|

Progress

[llllllllllllllllllllIIIIIIIIIIIII]

Fil= status
Fatal Errars: 1
Severe Emors: 1
W arnings: 1]

e ]
[ Prune ermoneous calls ]

Pruning erroneous (severe) calls

Deleting one or more of the calls must be followed by re-computing some file-level summary structures
like the “Audit Control Information” structure. This is done automatically without the user having to do
anything beyond agreeing to the following dialog:

Semantix Roaming Studio X

\;f/ Do wou want ko update the Audit Control Info, too?

| ves | [ Mo

Confirmation dialog for pruning of TAP3 severe calls

The user can also manually request a recalculation of the summary fields through the Validations=
Update Audit Control Info menu. Through this update, the pruning operation is guaranteed to not
introduce any discrepancies (usually a fatal error) in the file and yield a correct file (assuming of course
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the initial file had no fatal errors of its own).

However, it should be noted that the pruning operation will not and cannot in any way fix any fatal
errors. Calls with severe errors will be removed so the new file will not contain any severe errors but
pre-existing fatal errors or warnings will remain unaffected by the pruning process. Moreover, in many
cases it may not be appropriate to prune severe calls out of a file when that file also contains fatal
errors. The reason is that the validation logic is such that in many cases a fatal error in a file-level field
or structure can result in many calls identified as severe where in fact the root of the problem is not in
the calls themselves but in one or more file-level fields or structures. In these cases fixing the cause of
one fatal error can commonly result in many severe error complaints removed. Therefore it is usually a
good idea to try to fix any fatal errors before pruning erroneous calls (especially if you see a very large
number of severe calls as this typically indicates some other more central problem with the file
structure — a fatal error in many cases). Pressing the Prune erroneous calls button in the Validation
window will not prevent you from pruning severe calls out of a file with one or more fatal errors —
though it will issue a warning to that effect first.

Finally, it should be noted that in cases where the user manually deletes one or more calls from the file
(see Adding or removing composite structures), then, updating of the summary fields must be explicitly
requested by the user by selecting the Update Audit Control Info menu item from the Validations
menu.

9.4 Validations Results Pane

The Validation results pane holds the results of the latest validation. The Validation results pane is
depicted in the figure below.

|@ Fatal [|[.! ) Severe ||| ¥, Warnings || [E3 Mext Error |

Element Error Code Severity O, ., Descripkion
Call Tvpe Level 3 20 Severe 13 Yalue out of range.

Yalidation resulks | Call search results

The Validation results pane

The top part of the pane consists of three toggle buttons (Fatal, Severe and Warnings) that can be used
to toggle on and off the appearance of fatal errors, severe errors and warnings. Their effect is identical
in all respects to that of the Show Fatal, Show Severe and Show Warnings menu items of the
Validations menu and the two are synchronized (so when you deselect the menu item Validations
Show Warnings the Warnings check box is also toggled off. They are used to control three things:

o the appearance of the wavy underlines in the high-level view and detail view of a file

o the participation of validation errors of this type in the navigation loop that is activated every time the
users presses the F4 key or selects the Validations® Show Next Error menu item. Simply put, the
easiest way to browse through all of a file's fatal errors all you have to do is to toggle off the Severe
and Warnings checkboxes from the Validation results pane (or deselect the Show Severe and Show
Warnings menu items from the Validations menu) and press repeatedly the F4 key. With each F4
key press you will be automatically navigated to the next fatal error.
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¢ the errors that are listed in the Validation results pane tabular structure. Note that in contrast to the

Call search results pane validation errors listed in the Validation results pane are not clickable: i.e. you
cannot double click on an error and jump to its occurrence. This is because the Validations results
pane aggregates errors of the same type so double clicking on a error line in the list is actually
double-clicking on a class of similar errors and as such it can’t get you anywhere specific in the file.
Actually, double clicking on an error class does have an effect which is this: it toggles on and off the
participation of that error class in the F4 error browsing loop. So not only can you select whether you
want to browse through severe, fatal errors or warnings in your F4 loop (as described in the previous
bullet) but you can also select which particular fatal or severe errors or warnings will participate in
that loop. In this table listing the following information is identified for each validation error:

o Element: the name of the element under whose entry in the data dictionary of the relevant TD.57
specification is each error described

o Error Code: the error code for that validation in the data dictionary description for the relevant
element (see above) in the applicable TD.57 specification document

o Severity: one of “fatal”, “severe” or “warning”
o Occurrences: how many times this error appears in the validated file

o Description: the description provided for this error in the data dictionary of the relevant TD.57
specification.
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10

10.1

Modifying and Creating files

Roaming Studio is a fully featured TAP/RAP/NRTRDE editor. With it you can modify existing TAP/
RAP/NRTRDE files in any way you like. You can effect small scale changes as in changing the values
of individual fields (e.g. change a “charge” field) or adding or removing individual fields. You can also
effect larger scale, structural changes as in deleting or cut-pasting entire calls between files, removing
or adding entire substructures (at the call or file level), merging or splitting existing TAP/RAP/NRTRDE
files or even creating files from scratch. The purpose of this Chapter is to guide you through the most
common of these operations.

Modifying individual fields

Modifying individual fields takes place in the Detail view area of the Roaming Studio application as this
is the only place where the ultimate leaf-level fields are depicted. Recall from Chapter The Working
Environment that the other file view area, the File view area depicts only file level structures that carry
no individual fields — just other composite structures.

Modifying the value of an individual field is done in a standard Windows-interface way: just press F2 or
double-click the field and a text box will appear allowing you to enter a new value as depicted in the
figure below.
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" Semantix Roaming Studio - [C:\TAPKIT\SampleData\3.4\cdcypctgrepf02527%] x|
o=l File Edit Yiew Validations Configure  Windows  Help - 5 X
NS A @)ib G s X9 CfidEd v|& |d -HEN.
= 09 Dafaihierchangs A || = 53 batchContrallnfo
=05 transfarfatch ) | =3 |GR
M | batchControlInfo [ NI S| sreco
|03 accountinglnfo || =4| GRCPF
|3 networkInfo 25| GRCQT
=- Jb caflfvantDatais .| GRCSH DE0001
o5 11000 | GroCw
GRLTG
|3 [1] CED{Mo
| [2] CED{Ma =] TocalTimeStamp: zuuzmﬁnmada
|3 [3] CED{Ma 2] uweTimeDffset: +0200
|5 [4] CED{Ma = filedwailableTimeStamp
|5 [5] CED{Ma : [Z] localTimeStamp: 20020720081507
|3 [6] CED{Ma 2] utcTimeOffzet: +0200
D [FlCEDiMe || e [3] specificationtersionMumber. 3
o [E1CEDMa || e [0 releazeVersionMumber: 4
I [9] CED{Ma
|3 [10] CEDM
|3 [11] CED{M
{3 [12] CED{M |@ Fatal |®Severe || ¥, warrings || £ Mext Errar
|3 [13] CEDiM
5 [14] CED(M Elerment Error Code Severity C
-5 [15] CEDiM Zall Type Level 3 20 SEVErE 1:
|3 [16] CED{M
|3 [17] CEDiM
|3 [18] CEDiM
| [19] CEDiM
1) [20] CED(M 4 X
I [211.CEDM e || | validation results | Call szarch results

Ready

Press F2 or double-click any field to enter its new value

Modifications to the values of individual fields (as well as all editing actions on a file) are undoable up
to a practically infinite number of undo levels by pressing CTRL+Z or selecting Edit< Undo.
Conversely, they are also re-doable with CTRL+Y or Edit<+ Redo.

10.2 Adding or removing individual fields

As in modifying individual fields, adding or removing individual fields also takes place in the Detail view
area for the same reasons explained in Section Modifying individual fields. Removing a field is
performed simply by selecting a field and:

e pressing the DEL or CTRL+X key (delete or cut respectively)
e clicking the left mouse button and selecting Cut or Delete
¢ selecting the Cut or Delete menu items from the Edit menu

In all cases, pressing CTRL+Z or selecting Edit< Undo will undo the field removal (practically infinite
levels of undo are supported). Conversely, unlimited redos are also supported with CTRL+Y or by
selecting Edit+ Redo.
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Adding an individual field is equally intuitive: all you need to do is select the composite node under
which the field should "hung" in the Detail view pane, right-click with the mouse and select addEmptyChild
. Possible fields will appear in the pop up menu. Existing fields (which can of course no longer be
added) will be disabled leaving only fields which are currently missing, as depicted in the figure below:

= | CED[MoabileTerminatedCall]
=i miobileT erminatedCall
=R ] Do :icCalll nformation

=/ chargeabled =3 Copy
=iy simChar cut
=] imsi &
=] mais
=[5 calOriginatef X Delete
o typeElfH Save as template ..,
of] numberi
5| C?”'”E!N|~"_=| fdd new elerment > fraudtaonitorIndicakar
if] clilndic
=-{—3 callEventSts
=] localTimeStamp: 20020713725115 rapFile3equenceMumber

of] utcTimelffzetCode: 1
of totalCalEventDuration: 737
=i locationlnformation
=3 networkLocation ariginatingtetwork
of] recEntityCode: 1
g] calReference: 15236570
of] locationdrea: 21
- equipmentl nformation
=iy meidEsn
=) imei 449123879300640 causeFarTerm
--i basicServicelsedlist
=i [1] BasicServicelsed
=i basicService
- serviceCode

networkTwpe

simToolkitIndicator

- -

Adding an individual field. Observe that existing fields are disabled.

This way you have a context-aware add functionality which won't allow you to erroneously place a field
where it doesn't belong. Naturally, field addition is also undoable with CTRL+X or Edit Undo and re-
doable with CTRL+Y or Edit% Redo up to a practically infinite number of undo / redo levels.

Note that there is also a further way to add an individual field: this involves right-clicking on the parent
node and selecting Add element from template. This option is usually disabled unless a specific template
has been defined for a valid field type hanging under the structure that was right-clicked. This method
of adding fields is explained in Section Defining your own composite structure templates.

10.3 Adding or removing composite structures

Adding or removing composite structures is done in much the same way that adding or removing
individual fields is done (Section Adding or removing individual fields).

Recall that although individual fields appear only in the Detail view pane, composite structures can
appear both at the File view pane (file-level composite structures) and the Detail view pane (call-level
composite structures). Therefore although individual fields can be added or removed only in the Detail
view pane, composite structures and nodes can be added or removed both in the File view and the
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Detail view panes.

To remove a composite structure simply select this structure in the File view pane or Detail view pane
as appropriate (depending on where it appears) and either:

e press DEL or CTRL+X (delete and cut respectively)
e right-click and select Cut or Delete
¢ select the Cut or Delete menu items from the Edit menu

In all cases, pressing CTRL+Z or selecting Edit< Undo will undo the composite structure removal
(practically infinite levels of undo are supported). Conversely, unlimited redos are also supported with
CTRL+Y or by selecting Edit+ Redo.

Adding a structure is equally intuitive: all you need to do is select the composite "father" node under
which the new structure should "hung" in the Detail view or File view panes, right-click with the mouse
and select Add new element. Possible structures for the addition will appear in the pop up menu. Existing
structures (which can of course no longer be added) will be disabled leaving only structures which are
actually currently missing enabled as depicted in the figure below.

= | CED[SupplServiceEvent] A Data Dickionary
supplServiceEvent g
=] fraudMonitorlndi =4 ‘opy SupplServiceEvent
=] rapFileSequence & Cut
of metworkT ype: 1 1 .
-0 locationlnformatil supplServiceEvent
=73 equipmentinfom X Delete Validations 43M.1 Pavent T
i !'ncul?gegtatiu Save as template ... & Bupplementary Servic
= imeilEsn ek arnnme of i
=) imei 3505 Add new element C | L
=9 supplSerwceL!se chargeablesubscriber b
=] suppl3ervic — s

0f] suppl3erviceActionCode: 0 |
=) ssParameters: Forwarded ta Mumber A
=4 thirdPartpl nformation L
=] thirdPartyMumber: 306344222471

of] clrindicator: 0 b
=3 chargingTimeStamp i
=] localTimeStamp: 20050307100340

of] utcTimelffsetCode: 1 i
=i chargelnformation
=] chargedlter: D "‘

Orperator 3pecific Inform

i exchangeRateCode: [ present, this is optional

Adding a composite structure.

This way you have a context-aware add functionality which won't allow you to erroneously place a
structures where it doesn't belong. Naturally, structure addition is also undoable with CTRL+X or Edit <+
Undo and re-doable with CTRL+Y or Edit Redo up to a practically infinite number of undo / redo
levels.

Note that there is also a further way to add a composite structure: this involves right-clicking on the
parent node and selecting Add element from template. This option is usually disabled unless a specific
template has been defined for a valid structure type hanging under the parent structure that was right-
clicked. This method of adding fields is explained in Section Defining your own composite structure
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10.4

templates.

Defining your own templates

Semantix Roaming Studio allows you to define your own field or structure templates.

You can define any number of templates for any field or composite structure in a TAP/RAP/NRTRDE

file as you chose.

To define a field or structure template simply right-click on a field or structure of an file already open in
the editor and select Save as template... as depicted in the figure below.

] L L, OIS MILSL S )
I [4] CEDServiceCentrellsage)
I [5] CEDValueaddedService)

=] PURSULISEE s U
=] chargingCharactenstics: 2
=] rapFileSequenceMumber 03333

][] CEC(GprsCall) g
= [7] CED{ContentT) =
I [B] CED(Locationy 4
) auditControllnfo

Copy
Cuk

Delete

1Tupe: 1

tination

ezzFointMamet|: wap zer
ezzFointMamedl: wap zer
otePdpdddresslist

[1] PacketDataProtocaold.d

Save as template ...

ntStartTimeStamp

[TimeStamp: 2005030710
imeldffzetCode; 1
FventDuration: 30

el | e 4
0 nebworklnitPOPContest: 1
0f chargingld: 314153265
—-I—=3 gprsLocationlnformation
=43 gprsMetwaork Location

Saving an existing GPRS Call structure as a template.

Note that you can save templates from both the File view and the Detail view panes of the editor.

Selecting the Save as template.... command from the pop up menu that is displayed when the right
mouse button is clicked on an individual field or structure opens the save template dialog which is

depicted in the figure below.
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New Template Attributes f'5_<|

Template M ame
| CED(GprsCall |

D ezcription
A GPRS Call |

Exizting templatez under CallEwventDetailLizt for TAP310

Template Hame Drezcription

The save template dialog.

The save template dialog allows you to enter a name for your new template (you should chose an
intuitive name as you will need to select this name when you get to use the template in the future). It
also lists existing templates already defined under the same parent node.

Once a field or structure template is defined you can use it to add new fields or structures of that type.
You don't need to worry where it might get added though: the editor will automatically enable the Add
element from template... command in the popup menu that gets displayed after right-clicking on a field or
node whenever a field or node template for an appropriate type is defined. Thus, Add element from
template... is also context-aware and you cannot accidentally add a template where it can't belong.

Note also that templates are version specific. Therefore any templates saved e.g. from a TAP3.4 file
will only by available to add through Add element from template in appropriate nodes of TAP3.4 files and
in no other TAP releases (and not for NRTRDE/RAP files).

Finally, selecting Edit< Templates... allows you to view existing templates for every TAP/RAP/
NRTRDE version and remove templates you no longer need as depicted in the following figure:
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10.5

Templates |:|E]E|

Edit templates for version: | WRTRDE Yersion=02 Release=01 v
M arne Farent node Drescription
[ ] CED{Moc) allE wentList &, Mobile Originated Call
[ ] CED[Gprs] CallE wentList A GPRS call to e mykiceSite. com
Bemove selected ] ’ Ewport selected .. ak. ] ’ Cancel

The edit templates dialog.

Updating AuditControlinfo

Modifying a TAP/NRTRDE file is an inherently unsafe operation that can introduce new warnings,
severe errors or even fatal errors in a file unless done by a knowledgeable user. This applies both to
small-scale changes like changing the value of an individual field as well as — and more importantly —
to structural changes like adding or removing call-level or file-level composite structures or entire calls.
A TAP file contains important summary information in the form of the Audit Control Information
structure. In the case of NRTRDE files, they contain a CallEventsCount, which provides the total
number of calls. Both kinds of information are used for auditing purposes and are rigorously validated.
Most errors on AuditControlinfo are rated fatal in the TD.57 documentation for all TAP 3 releases - and
likewise for NRTRDE's CallEventsCount. Since these are in fact aggregates and summaries for all
calls present in the files, it is possible that if you change the value of a sensitive field like call charge or
call duration, the aggregates computed in this structure will no longer be valid resulting in a fatal file.
This is even more so if you don’t simply change the value of a field but add or remove entire calls or
other important structures. Therefore it is a good idea to request Roaming Studio to automatically
recalculate this information, taking into consideration any changes you may have effected on the file.
You can do this by selecting the Update Audit Control Info menu item from the Validations menu (for
NRTRDE, the menu item is named "Update Call Events Count").
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=)

5

J

Yalidations | Configure  windows

I

alidate File ... Chrl4+T

Create Validation Report

&

Update Audit Contral Info

— = — W7

HRRR

Shiows Eakal
Showe Severe
Show Warnings

Show Ervor Balloons

—_——— —

Requesting an update for AuditControlinfo

You may wish to consider however that this may also have a side-effect which is beneficial 99% of the

L)

71

time but there could be cases when it is not what you want. Since this structure is re-computed from
scratch overwriting existing information it can have the effect of also correcting fatal or severe errors

that pre-existed in the TAP/NRTRDE file and preceded any modifications you made or where
unrelated to them. This is usually a good thing but there could be cases where you wanted the original
severe and fatal errors to persist (e.g. maybe you wanted to report them or ask a vendor to fix

something). Therefore you should run and save a validation report before modifying a file just so that
you will have an idea where you stand. Better yet, always keep a copy of the original file. Also, run a

validation report after you are done modifying the file to make sure you have not inadvertedly

introduced any new errors in the file.
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Advanced Operations

Merging TAP3 files

Merging of TAP files is a process that takes as input two or more TAP3 files of the same TAP3 release
(e.g. 3.10) and produces a single TAP3 file of the same TAPS3 release with all their calls.

To merge two or more files simply choose File— Mergefiles... from the menu. The merge files dialog
will then appear as depicted in the figure below:

Merge TAP3 Files 3

Input TAP files

File Hame [L_:'-: Add File for Merging ... ]

C:4%Program FileshSemantizhSemanti= Foaming StudiohTDS7_TestCases\TAPI....
C:%Program FileshSemantihSemantix Boaming StudiohTDSY_TestCazes\TAPI...
C:AProgram FilezhSemantixhSemantix Boaming StudichTDE?_TestCazes\TAFI...

Output file name

C:\Pragram Files'SemantixsSemantix Roaming Studic\TOS7_T estCazes\TAPZ.03M E Set Merged File ..

The merge files dialog.

The merge files dialog allows you to add one or more TAP files (pick the TAP files you wish to merge
by clicking on the Add file button which brings up a standard Windows file chooser dialog) and set the
name and location of the merged TAP file to create (the Set button which brings up another standard
Windows file chooser dialog).

The merge functionality is completely independent of any underlying opened TAP file in Roaming
Studio and need not involve it in any way. This is why the File— Mergefiles... menu item is enabled
even if no file is presently opened in Roaming Studio.

Note that you can only merge TAP3 files of the same release and that even then, the sender and
recipient operators must be the same. The merging operation will complain if these conditions are not
met as depicted in the figure below.
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Merging of Files:

@ C:\Program Files\Semanti:iSemantix Roaming Studiol TDS7_TestCases\TAP3,03YCODEUD2GRCPF10000, ActionCode_10
C:\Program Files\SemantixiSemantix Roaming Studiol TDS7_TestCases)\TAP3, 02YCODEUD2GRCPF10000, AccountingInformation_33
inko File
Ci\Program Files)Semanti: Semantix Roaming Studio\ TDS7_TestCases\TAPS, 034kt

failed because aof the Follawing reason:
Mot all files hawve the same TAP wersion: 3.3 <> 3.2 |

(Al Files were version 3,3 up to File 'CiYProgram Files\Semantix:iSemantix: Roaming
Studiod TDS7_TestCases\TAPS.02_DLEUD2GR.CPF 10000, AccountingInformation_337!

Carrect all the errors reported above, and make sure wou always walidate all the input Files First.

You can only merge TAP files of the same version and sender-recipient pair.

The merged TAP file will carry internally the file sequence number of the first TAP file offered for
merging (this may not necessarily be the smallest file sequence number) so the name you indicate
with the Set button must match that number otherwise you will get a fatal validation error. In case
where you wish the merged file to carry a file sequence number which is not present in any of the
merged files your only option is to accept the file sequence number offered by default and then
manually edit the file to change its FileSequenceNumber field in the BatchControlinfo structure.

Finally note that there are certain bilaterally agreed limits that place certain constraints on the dates
and times of calls present in a TAP file relative to that file's cutoff timestamp or file available timestamp
or the present date and time. This means that there might be situations where merging correct TAP
files might yield an erroneous TAP file. However any validation error pronounced in this manner will be
on the basis of bilaterally agreed values which may thus be relaxed as an exception, via the Configure/
Validation Rules menu.

11.2 Splitting files

Splitting a TAP/RAP/NRTRDE files refers to the process of distributing the calls that are present in a

file into two other files. These files will then collectively contain all the calls found in the original TAP/

RAP/NRTRDE file and will have no calls in common between them. In set theory parlance, the set of
the two files that are created as a result of the split process constitute a partitioning of the calls found
in the original TAP/RAP/NRTRDE file: their union is the original file and their intersection is the empty
set.

Splitting a TAP file seen as partitioning operation from a set theory perspective.

Splitting a file in Roaming Studio is fully integrated with the advanced call search facility (see Section
Searching files). Therefore, to split a file you must first open a file (this would be the TAP/RAP/
NRTRDE file to split) and perform a call search. If you have not performed a call search or if the last
call search yielded no calls at all then the split operation will complain that it can not use a set of calls
to split with, as depicted in the figure below:
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Semantix Roaming 5tudio

Do you wank ko perform another call search now?

\:‘i) Last call search returned nao calls,

£ fes | [ Mo

By agreeing, you are offered a change to set the filtering rule, in the same way you would search for
these calls:

Call search ['5__<|
Call types
MobileQriginatedCal MobileT eminatedCall | Selectal| | Clearai |
SupplServicek vent [] ServiceCentrellzage from call indes
[] YaluetddedService [] GprsCal |1 = |
ContentT ransaction LocationService =
O O to call index
& +
Diefine more criteria
Field Condition Walue
v | vl|
(3 Match al
Fules (%) Match any
Field Condition Yalue
ak. l [ LCancel Ewport Queny ba kL

You must first perform a valid call search before you can split afile.

After performing a call search that yields at least some calls you can select Split File Using Last Call
Sear ch... from the Edit menu. The Split dialog depicted in the figure below will then be displayed.
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Semantix Roaming 5tudio

Select one of the following

(%) Create a new file with the calls selected by the last call search
() Create a new file with the callz not selected by the last call zsarch

() Create both files

Split dialog.

In the split dialog the user is provided with three options:

¢ he can create a file including all calls fetched by the last call search

¢ he can create a file including all calls not fetched by the last call search

¢ he can create both of the above files effectively splitting the initial file along the call search results

Note that strictly speaking only the third option splits the file. The first two options merely export a
subset of the file's calls into another file. Note also that in all three cases the split operation is
unobtrusive: the original file is not modified in any way.

Since the splitting operation is by its very design fully integrated with the call search operation the user
can use all the elaborate queries that the latter operation enables him to create. Refer to Section
Searching files for more information on constructing complex queries.

11.3 Exporting NRTRDE files to ASCII

Through the File/Export To/ASCII NRTRDE.. menu item, a simple ASCII based representation of the
currently opened NRTRDE file will be generated. The generated ASCII format includes all the
information of the original file:

10, 2, 1, " GRCPF", " DEUD2", " 0000001", "20080205140000", " +0200", 140

20, "262027352084232", "444788070366510", "20080205122105", "+0100", 1564, 0, "11", ,, "00436643313540", " 4366433135
30, "262027352084232", "444788070366510", "20080205122053", " +0200", 0, O, " 21", , "436643313540", " ST. POELTEN', 2,
40, "262022464569171", "49010041059856", "20080205124306", " +0200", 3269, 0, " WEB_CONNECT", " WEB_CONNECT", 13037646,
20, " 262027352084232", "444788070366510", "20080205125015", "+0100", 1803, 0, , "23",, "00436643313540", "4366433135.

See also the NRTRDE2ASCII Roaming Component on http://www.tapeditor.com
11.4 Exporting files to Excel/CSV

Roaming studio users might want to extract the information of a TAP / RAP or NRTRDE file into an
easy to process format. For example, the fraud detection department might expect reports, or graphs
on call charges.The File/Export To/Excel menu item offers this functionality:
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Export to Excel

MobileOriginatedCal | MabileT erminatedCall | SupplServiceEvent | Servic ¢ *

=7 bazicCallnformation - [ Save Erport Template ]
----- [ fraudtMonitorl ndicator
#-I~ chargeableSubscriber [ Load Export Template ]

----- [ rapFileSequenceMumber
----- [ networkType

=7 destination [ Expart to Excel ]
----- [w type0ftumber =
..... W numberingPlan [ Export to ASCIACSY ]

----- [w calledtumber

----- [ modificationl ndicator
----- [ calledPlace

----- [ calledR egion

----- [ calledMumdnalysizCode
----- [ Aestinatinnkb shwnrk

Cloze

£

tppeld i umber | rumberingPlan called umber calledPlace
h_ 1 0030932484022 | GREECE
0 0o (03094213000
1 1 (3094219000
0 0o (03094219000
1 1 (03094213000
0 0o (03094213000
1 1 (3094219000
0 0o (03094219000
1 1 (03094213000
0 0o 0035739551253 | CvPRUS MOBILE

MabileOriginatedCall | MobileT erminatedCal || SupplServiceE vent || ServiceCentrellzage || YaluetddedSer ¢ »

Exporting data to Excel

The dialog that pops up allows the user to specify what information he wishes to extract from the file.
The top half of the dialog contains a set of tabs, one for each call category (in the screenshot above,
MobileOriginatedCall, MobileTerminatedCall, etc). In this top half, the user can specify which fields he
wants to get in the generated Excel file, by just clicking on the desired fields. As soon as he clicks on
them, the bottom half fills with information from the currently opened file - a quick preview of what kind
of data will come through.

The set of selected fields can be saved (for future re-use) using the Save Export Template button, or
loaded using the L oad Export Template button.

By pressing the Export to Excel button, the user can then generate the desired output file, and open it
in Excel:
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Microsoft Excel - data.xml

P’—_‘_I] File Edit ‘Miew Insert Format  Tools Data  Window  Help Type aquestionforhelp = 2 & X
0SSR TE S AR08 =@ B rehome -
E21 - 2
A a8
Il typeOfNumber numberingPlan callediumber calledPlace
2 (1 0030932484022 GREECE
3 [0 0] 0035799551253 CHYPRUS MOBILE
410 0] 0035799351253 CYPRUS MOBILE
5 |1 1 0030932454022 SREECE
6 |1 1 0030932424022 GREECE
7|0 [u] 03094219000
g |0 0 03094219000
9 0 1] 0035796358335 CYPRUS MOBILE
1010 0 05393227 CYPRUS LEMESOS
1110 0] 0035724530560 CHPRUS LARNACA
1210 0 0035724530560 CYPRUS LARNACA
13 [0 0] 03054219000
14 [0 0] 02004219000
15 [0 1] 032094219000
16 1 1 0030944400111 GREECE
17 [0 [u] 192 CYPRUS
18 [0 1] 03094219000
19 [0 1] 0035726938697 CYPRLUS PAFOS
2000 0 030594219000
2110 0] 003572671655 CYPRUS LEFKOSIA 3
W 4 » W MobileOriginatedcall / T s 3l
Ready

Screenshot from exported file opened in Excel

The user can also click on the Export to ASCII/CSV button: in that case, the data are exported in a

simple ASCII format:

t ypeOf Nunber ; nunberi ngPl an; cal | edNunber ; cal | edPl ace

1; 1, 0030932484022; GREECE

0; 0; 0035799551253; CYPRUS MBI LE
0; 0; 0035799551253; CYPRUS MOBI LE
1;1;0030932484022; GREECE

1; 1, 0030932484022; GREECE

0; 0; 03094219000;

0; 0; 03094219000;

0; 0; 003579638335; CYPRUS MOBI LE

0; 0; 05393227; CYPRUS LEMESCS

0; 0; 0035724530560; CYPRUS LARNACA
0; 0; 0035724530560; CYPRUS LARNACA
0; 0; 03094219000;

0; 0; 03094219000;

0; 0; 03094219000;

Importing / Exporting files from / to XML

Roaming Studio enables users to import / export TAP, RAP and NRTRDE files from / to XML. Note
that Roaming Studio can only import XML files created with the "exporting to XML" facility of the
Roaming Studio itself. That is, it can import only its own XML format and not any other formats.
Roaming Studio uses its own XML schema known as the Roaming Studio XML Schema Definition.
This XML schema is also supported by the Roaming Components TAP2XML, XML2TAP and
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NRTRDE2XML:

<?xm version="1.0" encodi ng="utf-8" ?>
<TAP3Fi | e mj Versi on="3" mVer si on="11" xnl ns: xsi ="http://ww. w3. or g/ 2001/ XM_Schema- i nst ance" >
<Dat al nt er Change>
<transf er Bat ch>
<bat chControl I nf 0>
<sender >DEUD2</ sender >
<reci pi ent >GRCPF</ r eci pi ent >
<fil eSequenceNunber >10000</fi | eSequenceNunber >
<fil eCreationTi neSt anp>
<l ocal Ti neSt anp>20050907120940</ | ocal Ti meSt anp>
<ut cTi meOf f set >+0300</ ut cTi nexf f set >
</fileCreationTi meStanmp>
<t ransf er Cut O f Ti neSt anp>
<l ocal Ti neSt anp>20050907120940</ | ocal Ti meSt anp>
<ut cTi meCf f set >+0300</ ut cTi nexf f set >
</transferCut O f Ti meSt anp>
<fil eAvai | abl eTi neSt anp>
<l ocal Ti neSt anp>20050907120940</ | ocal Ti meSt anp>
<ut cTi meCf f set >+0300</ ut cTi neCxf f set >
</fil eAvail abl eTi meSt anp>
<speci fi cati onVer si onNunber >3</ speci fi cati onVer si onNunber >
<r el easeVer si onNunber >11</ r el easeVer si onNunber >
<r apFi | eSequenceNunber >09999</ r apFi | eSequenceNunber >
<oper at or Specl nf or mat i on>
<Oper at or Specl nf or nat i on>Test case generated with Semanti x Tool ki t </ Oper at or Specl nf or nat i on>
</ oper at or Specl nf or nmati on>
</ bat chControl I nf 0>
<accounti ngl nf o>
<t axati on>
<Taxati on>

An example of .e>'<r')orting a TAP file to XML

This schema is designed specifically for exporting files from the Roaming Studio for external
processing and re-importing them, and it is the only XML schema with which this is possible. The
Roaming Studio XML Schema Definition is derived from a simple association with the related TAP /
RAP / NRTRDE grammar: all variables in the ASN.1 grammar constitute their own XML nodes, and all
SEQUENCE_OF nodes enumerate their contents through nodes named after the contained element
type. This way it is easy for users to develop scripts or applications to either externally process the
Roaming Studio XML Schema or to modify the exported files automatically using a script or external
program and then re-import them as TAP / RAP / NRTRDE files with the modifications they have
incurred.

This is also the basic rationale behind the provision of this facility. Exporting files into a proprietary
XML format or importing XML files following the selfsame format makes sense mostly for one reason:
to allow the user to:

1. externally process TAP / RAP / NRTRDE files in an equivalent lossless representation as XML files
using external, third party text processing or XML processing tools

2. re-import the externally processed files in the TAP / RAP / NRTRDE format, internalizing the
externally-incurred changes

Less important, but still likely reasons would be to allow the XML representation to be viewed, edited or
manipulated by external XML-based tools and applications for purposes other than its re-importation
(e.g. reports).

Converting TAP files to other TAP versions

The Roaming Studio TAP editor can automatically convert existing TAPS3 files to other TAP3 releases
both upwards (e.g. convert from TAP3.9 to TAP3.11) and downwards (e.g. convert from TAP3.4 to

© 2011 Semantix Information Technologies S.A.



Advanced Operations 81

TAP3.1).

Simply choose: File— Export to— Another TAP3 release from the File menu. The TAP Conversion
dialog depicted in the figure below is then displayed.

Convert to another TAP 3 release E|

Target TAP3 releleaze [
v

Target File Hame
CATAPKIT\SampleDatat3 105CDDEUD2GRCPFI0000 fullta | [ |

Using this dialog the user is able to select the target TAP3 release, the target converted file's name
and location and either convert the file silently (i.e. without opening the converted file in the TAP editor)
or convert the TAP file and immediately open the converted version in Roaming Studio.

Corvvert ]

[ Cornvert and open l

Note that in all cases, the conversion process is unobtrusive, i.e. read-only as regards the original TAP
file to be converted which is not modified in any way.

Also note that conversion is a "best effort" process. What this means is that it is not always possible to
produce a 100% semantically equivalent representation of a TAP3 file in a different TAP version
especially as "semantically equivalent” may mean different things to different users and business
cases. The process has been implemented with the following, common sense, practical guides in
mind:

¢ sustain and preserve the essential file and call characteristics (e.g. charge, duration, A- and B-
numbers)

¢ when the original TAP file is valid, to any extent possible attempt to produce a converted TAP file
that does not contain any fatal or severe errors

¢ implement mappings of concepts or value lists when doing so is meaningful and reasonably correct
under all circumstances but refrain from any other mapping or mediation between formats that may
or may not be acceptable depending on the peculiar user requirements

Finally note that the conversion process behaves best when the original TAP file is valid. When the
original TAP file is not valid and contains fatal or severe errors the possibility increases that something
in the conversion process will go amiss. This is not to say that it is not possible to convert flawed TAP
files. The conversion process will simply issue a warning to that effect but will otherwise proceed and
perform a "best effort" conversion.

With this in mind the following methodology is proposed for converting TAP files:
1. validate the original TAP file

2. if there are any fatal or severe errors in the file it is advisable but not obligatory that you first attempt
to eradicate them by editing the file before proceeding with the conversion

3. validate the edited file again and take note of the fatal and severe errors in the file version which
was submitted for conversion. this will allow you to track whether the conversion process (in itself)
introduced any severe or fatal errors

4. convert the TAP file to the required target release and validate the converted file

5. if there are any fatal or severe errors which were not present in the original TAP file fix them
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manually using the Roaming Studio and/or report this issue to Semantix through our Mantis
database (http://www.tapeditor.com/mantis/).
Finally note that Semantix also offers (as a service) customized conversion profiles for customers with
unique requirements (e.g. convert GPRS calls into MOC calls with the same charging characteristics).
11.7 Anonymizing files
Anonymizing TAP/RAP/NRTRDE files refers to the process of removing sensitive information from a
file. The most obvious reason for doing something like that would be to yield a file which you could
freely share with your co-workers for testing or other purposes. It might also be useful when you want
to point an error in a file in a vendor so you need to send him the file but you want to strip it of any
personal or sensitive information. In general, whenever you need to share your files across your
department or your organization's boundaries. The anonymization process explicitly tries to preserve
existing severe or fatal errors as removing them would render it inappropriate for the purpose of
communicating errors or for testing purposes. In other words, the anonymization process statically
overwrites:
e Imsi
e Msisdn
e Imei
o AddressStringDigits
¢ DialledDigits
e CamelServerAddress
e CalledNumber
e CallingNumber
e CamelDestinationNumber
e ThirdPartyNumber
To anonymize a file simply chose File— Export to— Anonymized file... from the File menu. A standard
file dialog is then displayed allowing you to indicate the name and location of the anonymized file. Like
all other conversion / export operations that are accessible through the File— Export to menu, the
anonymization process is completely unobtrusive to the original file.
11.8 Configuring Reference Data

There are four categories of reference data that you might want to configure in the Roaming Studio
environment:

e Countries

e Currencies
 PMN Reference
¢ Validation rules

These are all accessible through the Configure menu and are each explained in the sections that
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follow.

Menu item Validation Rules.. of the Configure menu allows the user to modify the default validation
logic by either changing the severity of certain validations (e.g. from severe to fatal or to warning) or
changing the default ranges and value lists these validations check for. This functionality is described
in Overriding Default Validation Logic.

11.8.1 Configuring Countries
Country configuration refers to configuring dialling codes and currencies for countries.
The facility is accessed by selecting Configure— Countries... through the Configure menu.

The Countries tab at the Configuration dialog is then displayed as depicted in the figure below.

PrMs | Countries | Currencies
TREBIE of226 b Bl op K | Fiker |
0] Dezcription Dialing Code Currency ~
AFG AFGHAMISTAM 93 AFa,
ALB ALBAMIA, 385 ALL
b D24 ALGERIA, 213
A5 AMERICAMN SakOA 1634 LsD
AMD AMDORRA 76 EUR
AGO AMGOLA 244 A0
Al AMGUILLA, 1264 =D
ATG AMTIGUS AMND BARBLDA 1268 =CD
ARG ARGEMTIMA, 54 ARS
ARk ARMEMIA 7 A
AR ARLBA, 297 Al
ALIS ALSTRALLA E1 ALID w
Search Filter  Clear
[x]
Cornrnit

The dialog allows the user to examine and edit three properties for each country:

¢ the country's long name (description). This field is simply for identification purposes and does not
enter into any computation or validation

o the country's dialling code

o the country's currency. This is a three letter code uniquely identifying the currency used in that
country. Values in that field must also be present in the Currencies tab (described in Configuring
Currencies). An attempt by a user to indicate a currency code that fails to cross-reference with the
list of currencies set up in the Currencies tab of the Configuration dialog will result in a complaint by the
Roaming Studio to the effect that it can not identify the currency code indicated. To assist in this, if
you double click on the Currency field a lookup table will popup, allowing you to specify search
prefixes for the currency you seek, and eventually, double click on it;
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11.8.2

* Configure |§|

PMMs | Countries | Currencies |
A K 4 [s ofzzs| b bl |4 X [V Fiter ]

1] Drezcription Dialing Code Cumency ™

AFG AFGHAMISTAN 93 AR, =

ALB ALBAMIA 355 ALL

D4, ALGERIA 213 LEh

A5k AMERICAMN SAkOA 1684 sD

AND ANDORRA aTh ELUR

e 0L Select Value % |

Al AMGUILLA —
P ATG ANTIGUA &ND | 1T | Desciiption

ARG ARGENTINA E azt Caribbean Dallar

AP APMEMIA =0OF CF& Franc BCEAD

ABW ARUBA, AF CFA Franc BEALC

AlS AUSTRALLA =PF CFP Franc

Search Fiker  Clear

x] ||

Search Filker

& I

Apply Changes Feject Char

Selecting a currency

The country's three letter abbreviated form (country id in the first column) may not be modified as it is
the "primary key" of that table. Rows may be added or deleted to that table though.

As the table has been initialized according to international standards and reference lists identifying
country short names, dialling codes and currencies it is advised that only knowledgeable users should
modify these data.

Configuring Currencies

Currencies are configured by selecting Configure— Currencies... from the Configure menu.

This brings up the dialog displayed in the figure below.
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£ Configure rz|
Ptz | Countries | '
bW 4k X[ Fier |
Currency Dezcrption e
L3 DR SOR L
AFA, Afghani
AFM Afghani
ALL Leck
020 Algenan Dinar
Lsh IS Crollar
ELR Euro
ADP Andaorran Pezeta
ADA, Fwanza
=CD Eazt Caribbean Dallar
AR5 Argenting Peso
AbdD Armenian Dram b
Search Filter  Clear
%] |

Actually, since the Currency field is the primary key to the table and thus unmodifiable the only thing
that a user may change is the description of the currency. The description however is used only for
identification purposes and does not enter into any calculation or validation logic. Therefore the basic
mechanism to configure currencies is with the addition of new row when appropriate or the removal of
existing row when new currency units become obsolete.

Since the currency list has been initialized with valid values taken from reference international
standards only knowledgeable users should modify these data.

11.8.3 Configuring Other Networks

Other public mobile networks are configured through the PMNs tab of the Configure dialog depicted in
the figure below:
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11.9

£ Configure

X

i| Countries | Currencies

1 of632 b bl <k %[ Filter |

PrM 1D Dezcrption Country [D MCC MM ~
L3 ERACS CTEC Cellular BRA

BRALC4 CTEC Cellular ERA

BGRWA The Bulgarian Telecommunicatio... | BGRA

SLECH Cornium Siera leone IMC SLE

AMNTME E azt Caribbean Cellular AMT

R T Yiettel bobile Wb 452 04

USACD Cornmnet Wireless, LLC J5a

DhAGS Cable & Wireless Dominica Lid. D2,

LADAS LAT MOBILE LAD 457 03

IMDE 4 Hutch-K.armataka IMD

IMDE?2 Hutch-Chennai IMD

IMDE3 Hutch-&ndhra Pradesh IMD A

Search Filter  Clear

%]
Cornrmit

This dialog is accessible by selecting Configure— PMN Reference... from the Configure menu.

¢ The PMN ID column is the 5-letter mobile operator code and is a read only column and the primary
key to the networks table.

o The Description column is used simply for identification purposes and does not enter into any
calculation or validation logic.

¢ The Country ID column contains the country ID, as seen in the Countries dialog (see Configuring
Countries)

e The MCC column is the country-specific IMSI prefix for that operator
e The MNC column is the operator-specific IMSI prefix for that operator

Like all other reference configuration dialogs you are able to add or remove entries. The usual caveat
is also issued to the effect that the table has been initialized with reference data obtained from
authoritative lists so only knowledgeable users should modify these data.

Overriding Default Validation Logic

Validation logic is defined in the TD57 standards. Each validation rule (when not obeyed) results in one
of three error categories:

e Warning (not an important error)
e Severe (error invalidates the whole call)
o Fatal (error invalidates the whole file)

The first pane in the Validation Rules dialog allows the user to change the reported error level for a
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specific validation, through the "Severity" column.
The user can additionally disable a specific validation rule altogether, by toggling the "Enabled"”

checkbox:
Configure Validation Rules rz|
TAP Version | TAP3.11 v|  ActiveDate | Sunday, Januay 01, 200612 v |
Y alidations | Setz || Bilateral Agreements
Emaor Code Contest Enabled Serverity e
nink Manme M 10 GPRS Severs =
Access: Point Mame O 10 GPRS Severe b
Accounting |nformation 30 TiBatch Fatal b
Accounting Infarmation k] TiBatch Fatal b
Accounting Information 32 TIB atch Fatal ol
Accounting |nformation 33 TiBatch Fatal b
Accounting |nformation 34 TiBatch Fatal b
Accaunting |nfarmation 35 TiBatch Fatal b
Action Code 10 55 Severs v
Action Code 20 55 Severe e
Action Code 22 S5 Severs b
Actual Delivery Timestamp 10 Content Severs b
Artual Nelvero Timestarmn 1nn Cnntent [w1 Cavars |
Search Fiker  Clear
|| || | = v

In many cases, validation is simply checking for existence of one of a set of allowed values. These
sets are also modifiable through the "Sets" pane, by first selecting the desired set and then changing
its values in the "Selected set elements” grid. To ease the selection of a set, the pane also shows
which validation rules reference the particular set (in the bottom right grid).
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Configure Validation Rules
TAP Version | TAP3.11 v|  ActiveDate | Sunday, Januay 01, 200612 v |
| Walidations [58t3| Bilateral Agreements |
Set | Description Tupe ~
SupplServicedctionCodeS55et it -
SupplServicedctionCodelJS505 et int
AdvisedChargeSet it
AgedfLocationSet it
BearerServiceCodeSet zhring
CalEventDetailzCountS et int b

Search Filter  Clear

Selected zet elements Y alidation rulez uzsing the zelected set
DESCRIPTIOMN | WALLE #| | ELEMENT | ERROR CODE
 ErE—
" Erasue 1 L4
Activation 2
D eactivation 3
limbmrrmm = bmi A x

Cormmik Duplicate

Finally, some validation rules are toggled on or off based on a bilateral agreement between the two
operators (the sending and the receiving one). These can be adjusted from the "Bilateral Agreements"
pane:
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Configure Validation Rules

TAP Version | TAP3.11 v|  ActiveDate | Sunday, Januay 01, 200612 v |

Walidations || Sets | Bilateral.-’-‘-.greementsﬂ

D D escription Enabled
bl ze0fContentT ranzactiondgresd

bl ze0fServiceCentrel) zagedgreed

bl ze0f aluedddedServicedgresd

bl ze0fGprzCallbgresd

bl ze0fLocationServicedareed

bChargeT ypelll:E qualTaT heSumdf0thers
bEreakupQfChargeT ypes11031:E npectad
bt zizdnE xpected

blnterM etworkAccountingChargel sedgreed

bServingBidE spected

bServinglocationD ezcriptionk spected

bl ze0f0peratorS peclnfoliztbgreed

bT amationk xpected

bCamelCalE #pected

blizcountingE xpected

bPreviousivR eceivedindR ejectedWithFatal. .

JOEOREEOOOHR|[E EEIE

|1

Cormmik Duplicate

In all the grids where a lot of entries are shown, a "Search Filter" is also shown below them. This
allows the user to quickly see the entries he is interested in, by writing a "search phrase":

© 2011 Semantix Information Technologies S.A.



90

Semantix Roaming Studio

£ Configure

PMN: | Countries | Cumencies |

W[ efz e W g X[

PRM D

| Description

Country [0

MCC MHC

Hutzh-4ndhra Pradesh

IHD

Hutzch-4ndhra Pradesh

IMND

Search Filter  Clear

Zutch-4]

[x] ™

Apply Changes Beject Changes

. This can be simply a prefix (in the screenshot above, "IN" in the first column selects those PMNSs that
start with "IN") or a simple search expression using operator '%', which translates to mean "anything".
The second search column above contains "%utch-A", thus selecting all the records that contain in
their second column a string that contains "utch-A" somewhere inside them.
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12

Troubleshooting

When encountering any problem or issue which this user manual fails to anticipate please visit the F.A.
Q. at http://www.tapeditor.com/fag/ and/or email us with your question at support@tapeditor.com. If
you consider the behavior a bug, please take the time to register and report this bug in our bug-
tracking database at http://www.tapeditor.com/mantis/. We respond to all email inquiries within 24
hours and most of the time, much earlier. If applicable, your EULA may also identify certain phone-
support numbers which you can call to get your questions answered immediately by one of our
experts.

We very much welcome bug reports, feature wish-lists and any other comment on the product, this
manual (contents or organization) or our service. We view all such bug reports / comments /
complaints (especially complaints) as essential in improving our product line and services and we will
go out of our way to reciprocate the courtesy of any such communication.
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